## Table of Contents

- **Overview** ...................................................................................................................................................... 6
  - For all retention policy customers ........................................................................................................ 6
  - For retention policy managers .............................................................................................................. 6
  - For retention policy users .................................................................................................................... 6
- **Welcome to ImageNow Retention Policy Manager** .................................................................................. 7
- **Getting started** ............................................................................................................................................. 9
  - What are authorities? ................................................................................................................................ 9
  - Create an authority ................................................................................................................................... 9
  - Assign an authority .................................................................................................................................... 9
  - What are date periods? ............................................................................................................................. 9
  - Create a date period ................................................................................................................................... 9
  - What are physical locations? ................................................................................................................... 10
  - Create a physical location ....................................................................................................................... 10
  - What are physical file templates? ............................................................................................................ 11
  - About physical properties ........................................................................................................................ 11
  - Create a physical property ....................................................................................................................... 11
  - Create a physical file template ................................................................................................................ 13
- **What is Retention Policy Designer?** ....................................................................................................... 14
  - About phases ........................................................................................................................................... 14
  - About paths ............................................................................................................................................. 14
  - About path details .................................................................................................................................... 14
  - What are event rules? ............................................................................................................................. 15
  - What are time rules? ............................................................................................................................... 15
    - What are approvers? ............................................................................................................................ 15
    - What are disposition actions? ............................................................................................................. 16
  - About policy and phase protection ......................................................................................................... 17
  - About policies and document types ....................................................................................................... 17
- **Create simple policies** ............................................................................................................................. 18
  - Create a simple policy based on time and event .................................................................................... 18
    - Create the policy ................................................................................................................................. 18
Create the event rule ........................................................................................................................... 18
Set the retention period .......................................................................................................................... 19
Set action approvers .............................................................................................................................. 19
Set the disposition action ....................................................................................................................... 20
Inspect the policy .................................................................................................................................. 20
Protect the policy ..................................................................................................................................... 20
Save the policy ....................................................................................................................................... 20
Assign the policy to a document type ..................................................................................................... 20
Activate the policy .................................................................................................................................. 21
Create a simple policy based on an event .............................................................................................. 21
Create the policy ..................................................................................................................................... 21
Create the event rule .............................................................................................................................. 21
Create a time rule ..................................................................................................................................... 22
Set action approvers ............................................................................................................................... 22
Set the disposition action ....................................................................................................................... 22
Inspect the policy ..................................................................................................................................... 22
Protect the policy ...................................................................................................................................... 22
Save the policy ......................................................................................................................................... 23
Assign the policy to a document type ..................................................................................................... 23
Activate the policy .................................................................................................................................... 23
Create a simple policy based on time ..................................................................................................... 23
Create the policy ...................................................................................................................................... 23
Create the time rule and set the retention period .................................................................................. 24
Set action approvers ............................................................................................................................... 24
Set the disposition action ....................................................................................................................... 25
Inspect the policy ..................................................................................................................................... 25
Protect the policy ...................................................................................................................................... 25
Save the policy ......................................................................................................................................... 25
Assign the policy to a document type ..................................................................................................... 25
Activate the policy .................................................................................................................................... 26
Create advanced policies ......................................................................................................................... 27
Create an advanced policy based on time and event ............................................................................ 27
Create the policy ...................................................................................................................................... 27
Create the first phase and path ................................................................................................................ 27
Create the path event rule ....................................................................................................................... 28
Set the path time rule .............................................................................................................................. 28
Set action path approvers ....................................................................................................................... 28
Set the path disposition action ............................................................................................................. 29
Create an additional phase and path ................................................................................................... 29
Inspect the policy ................................................................................................................................. 35
Protect a phase .................................................................................................................................... 35
Save the policy ..................................................................................................................................... 35
Assign the policy to a document type .................................................................................................. 35
Activate the policy ................................................................................................................................ 35
Create an advanced policy based on an event ....................................................................................... 35
Create the policy .................................................................................................................................. 36
Create the first phase and path ........................................................................................................... 36
Create the path event rule ................................................................................................................... 36
Set the path time rule ........................................................................................................................... 36
Set action path approvers .................................................................................................................... 37
Set the path disposition action ............................................................................................................. 37
Create an additional phase and path ................................................................................................... 37
Inspect the policy ................................................................................................................................. 43
Protect a phase .................................................................................................................................... 43
Save the policy ..................................................................................................................................... 43
Assign the policy to a document type .................................................................................................. 43
Activate the policy ................................................................................................................................ 43
Create an advanced policy based on a time ........................................................................................... 43
Create the policy .................................................................................................................................. 44
Create the first phase and path ........................................................................................................... 44
Create the path time rule ................................................................................................................... 44
Set action path approvers .................................................................................................................... 45
Set path disposition action ................................................................................................................... 45
Create an additional phase and path ................................................................................................... 46
Inspect the policy ................................................................................................................................. 51
Protect a phase .................................................................................................................................... 51
Save the policy ..................................................................................................................................... 51
Assign the policy to a document type .................................................................................................. 51
Activate the policy ................................................................................................................................ 52
Retention sets ........................................................................................................................................... 53
About destruction sets .......................................................................................................................... 53
Generate a destruction set report ........................................................................................................ 53
Confirm a destruction set ....................................................................................................................... 53
About export sets .................................................................................................................................... 54
Overview

This guide is designed to provide you with step-by-step instructions on how to define retention policies and holds. How you use policies and holds will depend on your role, which ranges from administrator (records or departmental managers) to users who can apply documents holds from the ImageNow or WebNow Explorer. This guide contains the following sections:

For all retention policy customers

- “What is Retention Policy Manager?” introduces the license requirements and roles that are available in Retention Policy Manager. This section is written for records managers and departmental managers.

For retention policy managers

- “Getting started” introduces authorities, date periods, physical locations, and physical file templates. This section is written for records and departmental managers.
- “What is Retention Policy Designer?” introduces phases, path, path details, and protection for simple (one phase) and advanced (multiple phases) policies. This section is written for records and departmental managers.
- “Create a simple policy” explains how to create policies that contain a single phase and are time and event based, event based, and time based. This section is written for records and departmental managers.
- “Create an advanced policy” explains how to create policies that contain multiple phases and are time and event based, event based, and time based. This section is written for records and departmental managers.
- “Retention sets” introduces destruction, export, and move and copy sets. This section is written for records and departmental managers.
- “About holds” introduces holds, and explains how to create holds. This section is written for records and departmental managers.

For retention policy users

- “Using retention” introduces physical file references, approval tasks, and document holds. This section is written for users and departmental managers.
- “Reference” contains information about retention terms and hold privilege definitions.

More specialized topics on working with Retention Policy Manager are available from the Product Help, available in ImageNow.
Welcome to ImageNow Retention Policy Manager

In this section, you’ll learn the benefits and features of Retention Policy Manager and gain an understanding of retention policies, license requirements, and roles.

What is a retention policy?

A policy determines the length of time a document is retained and describes what to do with the document after the retention period expires.

What is Retention Policy Manager?

Retention Policy Manager allows you to manage the complete lifecycle of all information in your system automatically. With Retention Policy Manager, you can create time based, event based, and time and event based policies, track your physical documents, automate disposition actions, and apply litigation and audit holds.

You use Retention Policy Designer, accessible through Retention Policy Manager, to quickly define policies that contain single (simple) or multiple (advanced) phases. These policies allow you to transfer, permanently retain, and destroy all document types according to your organization’s requirements and legal standards. From Retention Policy Manager, you can create, rename, modify, and delete policies. Additionally, you can create authorities and define custom date periods for your policies.

Retention Policy Manager's physical file template capabilities allow you to track the physical location of your documents. With physical file templates, you can designate the building, shelf, or box location for your physical documents. You can use Retention Policy Manager to create, rename, copy, modify, and delete the physical file templates in your system. In addition, Retention Policy Manager provides reports so you know the location of the physical documents when you need to accession or transfer those documents.

After the retention period ends, Retention Policy Manager automatically creates sets for the documents you need to accession, transfer offline, and destroy. Users with the Manage Retention Policy privilege receive an e-mail notification after a set is complete. After you confirm a set, Retention Policy Manager removes the document pages, metadata, or both, depending on the disposition action. Retention Policy Manager provides reports for all set types and allows you to retry items if the system is unable to successfully process those items.

You can create litigation and audit holds that are permanent or have an absolute expiration date. When you apply a hold to a document in your system, you cannot modify or delete that document, even after the retention period ends. You can copy, modify, delete, and export any hold in your system. Retention Policy Manager's export functionality allows you to copy all of the documents under a hold to the offline location you define. A status report option displays a list of the document keys for documents that are under the currently selected hold and the document types assigned to that hold.

License requirements

To manage retention policies, holds, offline locations, and physical file templates, you must install the ImageNow Retention license. To create retention policies, you must install the ImageNow Retention Policy Designer license on your system.
Retention roles

ImageNow users take one the following roles when interacting with retention:

- **Owner or manager** – Can create or modify any policy and grant access privileges to policy managers. Additionally, a user with this role can create and modify any hold and grant access privileges to hold managers. To be an owner or manager, you must be a user with management privileges, a manager, or the owner.

- **Policy Manager** – Can create or modify any policy, authorities, date periods, physical locations, and physical file templates. In addition, a user with this role can confirm retention sets. To be a policy manager, you must have the global Manage Retention Policies privilege.

- **Hold Manager** - Can create, modify, or export any hold. In addition, you can grant users the ability to apply holds from ImageNow Explorer. To be a hold manager, you must have the global Manage Retention Holds privilege.

- **Retention User** – Can create physical file references, process approval tasks, and apply holds if he or she has the Assign from Grid privilege.

The owner or manager can create policies and holds or can delegate this task to one or more policy or hold managers. In any case, the owner or manager must first grant the Manage privilege to the policy or hold manager.

Grant retention policy manager privileges

To create and manage retention policies, you must have the global Manage Retention Policies privilege. With it, you can access the Retention area of the Management Console.

1. In the **Management Console**, to grant privileges to a user or group, perform one of the following actions:
   - To grant a privilege to a user:
     1. In the left pane, click **User**.
     2. In the right pane, on the **Security** tab, in the **Select a user** list, select a user and then click **Modify**. If the user you want is not listed, in the **Search for users** box, type all or part of a user name, first or last name, and then click **Search**. In the **Select a user** list, select one or more users and then click **Modify**.
   - To grant a privilege to a group:
     1. In the left pane, click **Groups**.
     2. In the right pane, on the **Security** tab, in the **Select a group** list, select a group and then click **Modify**. If the group you want is not listed, in the **Search for groups** box, type all or part of a group name and then click **Search**. In the **Select a group** list, select a group and then click **Modify**.

   **Note** To sort the **Select a group** list in ascending or descending order, click the **Name** column header.

2. In the **Security Settings** dialog box, click the **Global Privileges** pane.
3. In the **Privileges** list, under **Manage**, select the **Retention Policies** privilege.
4. Click the column to the left of the privilege so that ✅ displays to grant the privilege.
5. Click **OK** until you return to the **Management Console**.
Getting started

Before you create a policy, you can create authorities, date periods, physical locations, and physical file templates for that policy.

What are authorities?

An authority represents the legal, regulatory, statutory, or operational entity, such as the federal government or a legal department that defines the lifecycle requirements for a document. Specify an authority when you want to designate the entity that sets the requirements for a policy.

Create an authority

To perform this procedure, you must have the global Manage Retention Policies privilege. You can assign an authority to a policy during policy creation or from Retention Policy Designer.

1. In the Management Console, in the left pane, expand Retention.
2. Under Retention, click Policies.
3. In the right pane, on the Policy Authorities tab, click New.
4. In the New Policy Authority dialog box, perform the following substeps:
   1. In the Name box, type an authority name.
   2. Optional. In the Description box, type a description.
   3. Click OK.

Assign an authority

Perform this procedure to assign an authority from Retention Policy Designer.

1. In Retention Policy Designer, on the File menu, click Properties.
2. In the Policy Properties dialog box, under Authorities, click Modify.
3. In the Select Authorities dialog box, perform the following substeps:
   1. Optional. When the authority you want to assign does not appear under Search results, in the Search for authorities box, type all or part of an authority name and then click Search.
   2. Under Search results, select one or more authorities and then click Add. To select multiple authorities, select the first authority, hold down CTRL, and then click the remaining authorities.
4. Click OK.

What are date periods?

A date period is a period of time that you define, such as the start date for your company's fiscal year. You can use the date period as the basis of the retention period in a retention policy.

Create a date period

To perform this procedure, you must have the global Manage Retention Policies privilege. Date periods you define are available for assignment on the Time Period tab in Retention Policy Designer and have a duration period of one year.

1. In Management Console, in the left pane, expand Retention.
2. Under Retention, click Policies.
3. In the right pane, on the Date Periods tab, click New.

4. In the New Date Period dialog box, perform the following substeps:
   1. In the Name box, type a name for the date period.
   2. Optional. In the Description, type a description.
   3. In the Start month box, select a month and then in the Start day, select a day. By default, the current month and day display.

5. Click OK.

What are physical locations?

A physical location stores the documents that are exported as a result of an offline transfer or accession disposition action within a retention policy. To learn more about disposition actions, refer to the “What are actions?” section later in this guide.

To create a physical location, you define a name and output directory. The name you define displays in Retention Policy Designer. When the disposition action is set to Offline transfer or Accession, you associate a policy with a physical location by selecting the name of the location. In addition to defining a name and output directory for a physical location, you can also define a notification user or group. This user or group receives an e-mail notification when an export, copy, or move set for that physical location is complete.

As part of the physical location definition, you define a name for the output directory, such as HR 2012. After you save the physical location, Retention Policy Manager creates the specified directory, HR 2012 in this example, on the ImageNow Server in the [drive:]\inserver6\output_agent\export directory. When you create a physical location, you must associate that location with a physical file template. For more information about physical file templates, refer to the “What are physical file templates?” section.

Create a physical location

To create and manage physical locations, you must have the global Manage Retention Policies privilege unless you are a manager or owner. When the retention period duration ends, Retention Policy Designer exports the documents to the output directory defined for the selected physical location.

1. In Management Console, in the left pane, expand Retention.

2. Under Retention, click Physical Locations.

3. In the right pane, on the Physical Locations tab, click New.

4. To create a physical location, in the New Physical Location dialog box, perform the following substeps:
   1. In the Name box, type a location name.
   2. Optional. In the Description box, type a description for the location.
   3. In the Output directory box, type a directory name.

   Note Retention Policy Manager creates a directory on the ImageNow Server using the name you provide in the Output directory box. This directory stores the documents that are exported as a result of an offline transfer or accession disposition action.

   4. To associate a physical file template with the physical location, in the Physical file template list, select a template.
5. To send an e-mail notification to a user or group when a physical set is available, in the Notification user section, perform one of the following actions:

- To notify a user, select User and then select a user.
- To notify a group, select Group and then select a group.

**Note** A user or group member must have an e-mail address configured in his or her user profile in order to receive an e-mail notification.

5. Click **OK**.

### What are physical file templates?

With Retention Policy Manager's physical file templates capabilities, you can track the physical location of your documents. You can create a physical file template when you want to designate the building, shelf, or box location for your physical documents. You define a physical file template using physical property data types, such as strings, numbers, or predefined lists.

After you create a physical file template, you can use that template to create a physical file reference for any document in your system. When a retention policy disposition action is set to Destruction and the documents under that policy have physical file references, Retention Policy Manager creates a destruction set.

A destruction set allows you to view the electronic document and the associated physical file reference. You can use the destruction set information to inform your storage facility that there are documents that need to be destroyed. For more information about destruction sets, refer to the "About destruction sets" section.

### About physical properties

Before you can create physical file templates, you must first define physical properties. You define a physical property using one of the following data types: strings, numbers and currency, dates, predefined lists, or flags (true or false). Formatting settings let you control the data entry and display appearance of the physical property.

### Create a physical property

To perform this procedure, you must have the global Manage Retention Policies privilege. Before you can create a physical file template, you must define physical properties to assign to that template.

1. In the Management Console, in the left pane, expand Retention.
2. Under Retention, click Physical Locations.
3. In the right pane, on the Physical Properties tab, click **New** and then select one of the following data types:

   - **Date**
     1. In the New Date Property dialog box, in the Name box, type a physical property name.
     2. Do one of the following options:
        - To always use the current date as the default value, verify that the Default to the current date check box is selected.
        - To select a date for the default value, clear the Default to the current date check box, click the Default value arrow, and then on the Calendar control, select the default date for this physical file reference.
        - To use no default date, leave the Default value empty and then clear the Default to current date check box.
3. In the **Display Format** section, select the **Month**, **Day**, **Year**, and **Weekday** check boxes to show the respective portion of the date.

   **Note** To hide a portion of the date, clear the corresponding check box.

4. Click **OK**.

**Flag**

1. In the **New Flag Property** dialog box, in the **Name** box, type a physical property name.
2. Optional. In the **Default value** list, select **True** or **False** for the default value for this physical property. If you leave this setting empty, no default value appears for the physical property.
3. In the **Positive Label** box, type the value to display when the condition is true.
4. In the **Negative Label** box, type the value to display when the condition is false.
5. Click **OK**.

   **Note** The Flag property stores values of 0 or 1 based on the value that is selected by the user. The **Positive Label** and **Negative Label** boxes allow you to change the labels.

**List**

1. In the **New List Property** dialog box, in the **Name** box, type a physical property name.
2. Optional. In the **Default value** list, select the default item value for this physical property. You cannot set this value until you add at least one value to the list.
3. To add items to the list, under **Display Format**, do the following substeps:
   1. Click **Add**.
   2. Type the value for the list item and then press ENTER.
   3. Continue performing these substeps to add each value you want in this list.
4. Optional. Use the **Move Up** and **Move Down** buttons to rearrange the order of the list items.
5. Click **OK**.

**Number**

1. In the **New Number Property** dialog box, in the **Name** box, type a physical property name.
2. Optional. In the **Default value** box, type the number that is the default value for this physical property.
3. In the **Format** list, select **Decimal** or **Currency**.
4. If you selected **Currency** in the **Format** list, select **USD**, **GBP**, or **EUR**.
5. In the **Decimal Places** box, type or select the number or decimal places.
6. If you selected **Decimal** in the **Format** list, select **Fixed** or **Varying**.
7. To remove the thousands separator from numbers greater than 999, clear the **Punctuate at thousands** check box.
8. Click **OK**.

**String**

1. In the **New String Property** dialog box, in the **Name** box, type a physical property name.
2. Optional. In the **Default value** box, type the default string value for this physical property.
3. Click **OK**.
Note  You can also create a physical property by copying an existing physical property that is similar to
the one you want to create and modifying it. To do this, select the existing physical property in the list and
then click Copy.

Create a physical file template

To perform this procedure, you must have the global Manage Retention Policies privilege. After you
create a physical property, you can assign that property to any physical file template in Retention Policy
Manager.

1. In the Management Console, in the left pane, expand Retention.
2. Under Retention, click Physical Locations.
3. In the right pane, on the Physical File Templates tab, click New.
4. In the New Physical File Template dialog box, on the General tab, perform the following substeps:
   1. In the Name box, type a name.
   2. Optional. In the Description box, type a description.
5. On the Physical Properties tab, perform the following substeps:
   1. In the By type list, select the property type you want to display, such as Date, Number, or List.
      To display all physical property types, click All.
   2. Under Available, select from the available list of physical properties and then click Add.
   3. Optional. Click Move Up or Move Down to change the order in which the physical properties
      appear in a physical file template.
6. Click OK.
What is Retention Policy Designer?

Retention Policy Designer allows you to manage the complete lifecycle of the documents in your ImageNow system. With Retention Policy Designer, you can create the event based, time based, or time and event policies you need to meet your retention schedule requirements. Retention Policy Designer allows you to create simple and advanced policy types.

A simple policy contains a single phase and path, while an advanced policy contains multiple phases, multiple paths, or both. To determine what documents can fall under a policy, you assign a document type to that policy. Retention Policy Designer allows you to assign one or more document types to a policy. After you assign a document type to a policy, documents indexed with that document type automatically fall under the policy.

Both simple and advanced policy types contain phases, paths, and path details. A phase is a stage, such as online, offline, protected, and unprotected in a document’s lifecycle. Paths, together with the options you set for them, determine where a document falls under a policy. For each path you define, you must also define path details. These details include event, time, or event and time based rules for a path in a phase, the duration of the retention period, and the disposition action that occurs when the retention period ends.

About phases

A retention policy can contain a single phase (simple policy) or multiple phases (advanced policy). A phase contains paths.

Paths are sequential. To move to the next phase in a policy, a document must meet the current phase conditions. You can designate a phase as protected. While documents are in a protected phase, you cannot modify or delete the documents. By default, phases are unprotected.

About paths

Paths determine the location of a document during a phase. Paths, together with the options you set for them, determine where a document falls when under a policy. Each path has its own set of options, called details. Details can include an event rule, the retention period duration, and the disposition action that occurs at the end of that period.

The number of paths you define depends on the document type you assign to the policy. Document types are often associated with multiple custom properties and drawers. Instead of creating a separate policy for each custom property or drawer for that document type, you can create multiple paths. For example, consider the document type, "Administration documents." The Administration department assigns memos, meeting minutes, and contracts to this document type and the retention period for each of these documents varies. To address this scenario, you can create an advanced policy that contains a single phase and three paths, one for each type of administration document. You can then set the retention period and disposition action for each of these paths.

When there are multiple paths, Retention Policy Designer evaluates the paths in the order they display to determine where to place a document. A document can follow only a single path within a phase.

About path details

You define path details to set up the event, time, or event and time based rules for a path in a phase, the duration of the retention period, and the disposition action that occurs when the retention period ends. When you define a path, you must also set the details for that path.

A document falls under a path in a policy when it meets the rule conditions you define. Rules are based on events, times, or a combination of an event and a time. To set the duration of the path retention period, you select a date type, such as a system date, custom property date, or a date period you define. When the retention period ends, a disposition action occurs. You set a single disposition action for each path. Disposition action options include destruction, permanent, and accession. You can assign a user or
group to approve the disposition action before it occurs. An approver receives an e-mail notification when his or her approval is required.

**What are event rules?**

An event rule allows a document to fall under a path in a policy based on an event. You define event rules using one or more of the following conditions: custom properties, document keys, and task properties.

For example, consider a retention policy for contracts. "Contracts," the document type assigned to the policy, is associated with the custom property, "Approval status." An approval status is either "Approved" or "Denied." You want to retain approved contracts for two years and denied contracts for one year. To meet these requirements, you create an advanced policy that contains a single phase and two paths—one for each approval status. The first path you define is for approved contracts. For this path, you create an event rule using the custom property, "Approved." To address denied contracts, you create a second path and create an event rule using the "Denied" custom property. Retention Policy Designer evaluates the event rules to determine the appropriate path for the contracts.

**What are time rules?**

A time rule determines the duration of the retention period when an event rule is also defined for the policy or to create a time based policy. The date type you select for the rule determines the duration options available.

**Event based policies**

When you define an event based policy, a document is eligible for the disposition action immediately after the specified event occurs. For example, you might destroy documents upon completion of a city government audit. For this type of policy, there is no retention period duration. To use this action, you configure a time rule as immediate. Then when the event occurs, the disposition action occurs immediately. You can also create a time rule that establishes a particular date. When you set a date, both the event and the date must occur before the disposition action occurs.

**Event and time based policies**

An event and time based policy applies a retention period after the specified event rule conditions are met. For example, suppose you need to destroy a paid invoice three years from the paid date. To create this type of policy, you must create a time rule that allows you to set the starting date and duration of the retention period. To meet these requirements, Retention Policy Designer provides the following date types: custom property, date period, event date, and system date.

**Time based policies**

A time based policy allows a document to fall under that policy based on a date. This type of policy does not contain an event rule. Instead, the start and duration of the policy are based solely on time. For example, you could start the policy at the end of the fiscal year, retain documents for two years from this date, and then destroy them. To create a time rule that allows you to set both the start date and duration of the retention period, you select custom property, system date, or date period as the date type.

**What are approvers?**

An approver is a user or group member who must approve the disposition action set for a path before that action can occur. When the retention period ends, an approval request notification e-mail is sent to an approver. This notification contains a link to an approval request task. To approve the disposition action, the approver simply completes the approval request task assigned to the set of documents that are ready for approval. An approver can view the documents before approving them. In addition to assigning approvers, you can also provide instructions. These instructions appear in the e-mail notification sent to all approvers and in the approval request task pane.
Approval levels

Use approval levels to assign a series of approvals that are sequential. Suppose your policy has three approval levels. An individual approval request task is generated for each user or group member you assign to a level in the series. You can also assign a number of approvers from the users identified for each level. An approval series starts with Level 1. When the approval request task for Level 1 is approved by all users or group members, a new approval request task is created for the approvers on Level 2. When the Level 2 approval request task is approved, a new approval request task is created for the Level 3 approvers. You can assign the same users or group to multiple levels. The disposition action cannot occur until all levels of approval are complete.

What are disposition actions?

You set a disposition action to determine what happens to a document when the retention period ends. Retention Policy Designer offers the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accession</td>
<td>An action that transfers physical custody of documents to another owner, such as an archival institution. When you select this action, you can choose to delete documents and metadata (final), delete document pages and retain metadata (not final), or retain documents and metadata (not final). The option you select determines whether or not accession is a final disposition action.</td>
</tr>
<tr>
<td>Destruction</td>
<td>A final action that deletes documents permanently from the ImageNow system.</td>
</tr>
<tr>
<td>Next phase</td>
<td>An action that allows documents to move from an unprotected phase to a phase that is protected.</td>
</tr>
<tr>
<td>Offline transfer</td>
<td>An action that exports and transfers documents to a physical location.</td>
</tr>
<tr>
<td>Online transfer</td>
<td>An action that transfers documents to a new OSM set available to the ImageNow Server.</td>
</tr>
<tr>
<td>Permanent</td>
<td>A final action that preserves a document indefinitely.</td>
</tr>
</tbody>
</table>

The number of phases in a policy determines the disposition action you set. When there is a single phase, you must set a final disposition action (accession, permanent, or destruction) for each path in that phase. If an advanced policy contains multiple phases, the location of the path also determines the disposition action you set for that path. For example, when an advanced policy contains three phases, to ensure that a document can proceed from phase one to phase two, and so on, you must set at least one path in phase one and two to a disposition action that is not final, such as online transfer or next phase. In addition, because phase three is the last phase, you must set all paths in this phase to final disposition actions.
About policy and phase protection

With Retention Policy Designer, you can protect any simple policy or phase in an advanced policy. When you protect a policy, you cannot modify or delete the documents that fall under that policy, but you can transfer or accession them. Similarly, when you protect a phase, you cannot modify or delete the documents that fall under that phase, but you can transfer or accession them. Accession means that you are transferring the physical custody of a document to a new owner, such as an archival institution. By default, policies and phases are unprotected. When you want the ability to modify or delete documents under a policy, configure the policy or phase to remain unprotected.

About policies and document types

You assign a specific document type to a policy. After you assign the document type to a policy and activate that policy, Retention Policy Designer automatically places all documents indexed with that document type under that policy. You can assign multiple document types to the same policy. The document type you assign to a policy also determines the rules you can create for that policy.

When you define an event rule, the conditions you define for that rule must be associated with the document type assigned to the policy.
Create simple policies

A simple policy contains a single phase and path. For a simple policy, you must select a disposition action that is final, such as destruction or permanent.

Create a simple policy based on time and event

Follow these procedures to base a policy on an event. With this policy type, you create a time rule to determine the retention period. This section assumes you have created any needed document types and custom properties.

1. In Management Console, in the left pane, expand Retention.
2. Under Retention, click Policies.
3. In the right pane, on the Policies tab, click New. The Retention Policy Designer window opens.

Perform the following procedures in order.

Create the policy

1. In the New Policy dialog box, under Information, in the Name box, type a policy name, such as the record series name.
2. Optional. In the Identifier box, type an identifier, such as the record series code.
3. Optional. In the Description box, type a description of the documents included under this policy.
4. Optional. To assign a retention authority, such as an agency or regulatory body, with which the policy complies, under Authorities, click Add. In the Select Authorities dialog box, perform the following substeps:
   1. Optional. When the authority you want to assign does not appear under Search results, in the Search for authorities box, type all or part of an authority name and then click Search.
   2. Under Search results, select one or more authorities and then click Add. To select multiple authorities, select the first authority, hold down CTRL, and then click the remaining authorities.
   3. Click OK.
5. Click OK.

Create the event rule

1. On the Event tab, click the Add button.
2. In the Add Condition dialog box, perform the following substeps:
   1. In the Constrain by list, click the kind of constraint that sets up the lists you need in the Type, Field, and Operator boxes.
   2. In the Type list, verify that Normal displays.
   3. In the Operator list, select an operator, such as "is equal to" or "is greater than," that is used in the comparison.
   4. In the Value box, select or type a value to be compared to the item, using the selected operator.
   5. Click OK.
3. To add more rule conditions, repeat the previous substeps.
Set the retention period

- On the **Time Period** tab, in the **Date type** list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Type</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom property date</td>
<td>Click <strong>Custom property</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, to start the policy using a custom property date, select the date name.</td>
</tr>
<tr>
<td>Date period</td>
<td>Click <strong>Date period</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, select a date period. In the <strong>When</strong> list, to start the policy when the date period begins or ends, select <strong>Begin</strong> or <strong>End</strong>.</td>
</tr>
<tr>
<td>Event date</td>
<td>Click <strong>Event date</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years.</td>
</tr>
<tr>
<td>System date</td>
<td>Click <strong>System date</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, to start the policy using a system date, select <strong>Creation date</strong>, <strong>Last viewed date</strong>, or <strong>Last modified date</strong>.</td>
</tr>
</tbody>
</table>

Set action approvers

This procedure is optional.

1. Click the **Approvers** tab.
2. Perform one of the following actions:
   - To assign users, click **Add Users**. In the **Select Users** dialog box, under **Search results**, select one or more users, click **Add**, and then click **OK**. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.
   - To assign a group, click **Add Group**. In the **Select Group** dialog box, under **Search results**, select a group and then click **OK**.
3. If you need additional levels of approval, click **Add Level** and then repeat the previous step.
4. Optional. In the **Instructions** box, type the instructions you want to display to all approvers when processing approval requests.
Set the disposition action

- On the Action tab, in the Select the action to perform list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Accession          | 1. Click Accession. To delete the documents and associated metadata, in the Select a removal method for documents after accession list, click Delete documents and metadata.  
2. To select the accession location, in the Select the physical location list, select a physical location. |
| Destruction        | To destroy documents, click Destruction. |
| Permanent          | To permanently retain documents, click Permanent. |

Inspect the policy

- If you want to view the options you set for the policy, in the Details column, click the Summary tab.

Protect the policy

- If you want to protect the policy, on the Edit menu, click Protect Policy.
  
  **Note** A user cannot modify or delete any documents under a protected policy.

Save the policy

- On the File menu, click Save. After you save the policy, that policy remains inactive.
  
  **Note** The policy remains inactive.

Assign the policy to a document type

1. On the File menu, click Assign and then perform the following substeps:
   1. In the <Policy Name>: Assignment dialog box, on the Document Type tab, click Add.
   2. In the Select Document Types dialog box, perform the following substeps:
      - Optional. If the document type you want to assign does not appear under Search results, in the Search for document types box, type all or part of the document type name and then click Search.
      - Under Search results, select one or more document types and then click Add. To select multiple document types, select the first type, hold down CTRL, and then click the remaining types.
   3. Click OK.

2. Click OK.
Activate the policy

Note that after you activate a policy, you cannot modify the event rule, time rule, or disposition action set in that policy.

1. On the File menu, click Activate.
2. Close Retention Policy Designer.

Create a simple policy based on an event

Follow this procedure to base a policy on an event. With this policy type, you create a time rule to determine when the disposition action occurs. This section assumes you have created any needed document types and custom properties.

1. In Management Console, in the left pane, expand Retention.
2. Under Retention, click Policies.
3. In the right pane, on the Policies tab, click New. The Retention Policy Designer window opens. Perform the following procedures in order.

Create the policy

1. In the New Policy dialog box, under Information, in the Name box, type a policy name, such as the record series name.
2. Optional. In the Identifier box, type an identifier, such as the record series code.
3. Optional. In the Description box, type a description of the documents included under this policy.
4. Optional. To assign a retention authority, such as an agency or regulatory body, with which the policy complies, under Authorities, click Add. In the Select Authorities dialog box, perform the following substeps:
   1. Optional. When the authority you want to assign does not appear under Search results, in the Search for authorities box, type all or part of an authority name and then click Search.
   2. Under Search results, select one or more authorities and then click Add. To select multiple authorities, select the first authority, hold down CTRL, and then click the remaining authorities.
   3. Click OK.
5. Click OK.

Create the event rule

1. On the Event tab, click the Add button.
2. In the Add Condition dialog box, perform the following substeps:
   1. In the Constrain by list, click the kind of constraint that sets up the lists you need in the Type, Field, and Operator boxes.
   2. In the Type list, verify that Normal displays.
   3. In the Operator list, select an operator, such as "is equal to" or "is greater than," that is used in the comparison.
   4. In the Value box, select or type a value to be compared to the item, using the selected operator.
5. Click OK.
3. To add more rule conditions, repeat the previous substeps.
Create a time rule
- On the Time Period tab, in the Date type list, perform one of the following actions:
  - To set the disposition action to occur immediately, click Immediate.
  - To set the disposition action to occur on a fixed date, click Standard date and in the Date list, in the calendar control, select a date.

Set action approvers
This procedure is optional.
1. Click the Approvers tab.
2. Perform one of the following actions:
   - To assign users, click Add Users. In the Select Users dialog box, under Search results, select one or more users, click Add, and then click OK. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.
   - To assign a group, click Add Group. In the Select Group dialog box, under Search results, select a group and then click OK.
3. If you need additional levels of approval, click Add Level and then repeat the previous step.
4. Optional. In the Instructions box, type the instructions you want to display to all approvers when processing approval requests.

Set the disposition action
- On the Action tab, in the Select the action to perform list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Accession          | 1. Click Accession. To delete the documents and associated metadata, in the Select a removal method for documents after accession list, click Delete documents and metadata.  
2. To select the accession location, in the Select the physical location list, select a physical location. |
| Destruction        | To destroy documents, click Destruction. |
| Permanent          | To permanently retain documents, click Permanent. |

Inspect the policy
- If you want to view the options you set for the policy, in the Details column, click the Summary tab.

Protect the policy
- If you want to protect the policy, on the Edit menu, click Protect Policy.
  - Note  A user cannot modify or delete any documents under a protected policy.
Save the policy

- On the File menu, click Save.
  
  Note The policy remains inactive.

Assign the policy to a document type

1. On the File menu, click Assign and then perform the following substeps:
   1. In the <Policy Name>: Assignment dialog box, on the Document Type tab, click Add.
   2. In the Select Document Types dialog box, perform the following substeps:
      1. Optional. If the document type you want to assign does not appear under Search results, in the Search for document types box, type all or part of the document type name and then click Search.
      2. Under Search results, select one or more document types and then click Add. To select multiple document types, select the first type, hold down CTRL, and then click the remaining types.
      3. Click OK.

2. Click OK.

Activate the policy

Note that after you activate a policy, you cannot modify the event rule, time rule, or disposition action set in that policy.

1. On the File menu, click Activate.
2. Close Retention Policy Designer.

Create a simple policy based on time

Follow this procedure to base a policy on an event. With this policy type, you create a time rule to determine when the disposition action occurs. This section assumes you have created any needed document types and custom properties.

1. In Management Console, in the left pane, expand Retention.
2. Under Retention, click Policies.
3. In the right pane, on the Policies tab, click New. The Retention Policy Designer window opens.
   Perform the following procedures in order.

Create the policy

1. In the New Policy dialog box, under Information, in the Name box, type a policy name, such as the record series name.
2. Optional. In the Identifier box, type an identifier, such as the record series code.
3. Optional. In the Description box, type a description of the documents included under this policy.
4. Optional. To assign a retention authority with which the policy complies, such as an agency or regulatory body, under Authorities, click Add. In the Select Authorities dialog box, perform the following substeps:
   1. Optional. When the authority you want to assign does not appear under Search results, in the Search for authorities box, type all or part of an authority name and then click Search.
   2. Under Search results, select one or more authorities and then click Add. To select multiple authorities, select the first authority, hold down CTRL, and then click the remaining authorities.
   3. Click OK.
5. Click OK.

Create the time rule and set the retention period
- On the Time Period tab, in the Date type list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Type</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom property date</td>
<td>Click Custom property. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years. In the From list, to start the policy using a custom property date, select the date name.</td>
</tr>
<tr>
<td>Date period</td>
<td>Click Date period. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years. In the From list, select a date period. In the When list, to start the policy when the date period begins or ends, select Begin or End.</td>
</tr>
<tr>
<td>System date</td>
<td>Click System date. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years. In the From list, to start the policy using a system date, select Creation date, Last viewed date, or Last modified date.</td>
</tr>
</tbody>
</table>

Set action approvers
This procedure is optional.
1. Click the Approvers tab.
2. Perform one of the following actions:
   - To assign users, click Add Users. In the Select Users dialog box, under Search results, select one or more users, click Add, and then click OK. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.
   - To assign a group, click Add Group. In the Select Group dialog box, under Search results, select a group and then click OK.
3. If you need additional levels of approval, click Add Level and then repeat the previous step.
4. Optional. In the Instructions box, type the instructions you want to display to all approvers when processing approval requests.
Set the disposition action

- On the Action tab, in the Select the action to perform list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Accession          | 1. Click Accession. To delete the documents and associated metadata, in the Select a removal method for documents after accession list, click Delete documents and metadata.  
2. To select the accession location, in the Select physical location list, select a physical location. |
| Destruction        | To destroy documents, click Destruction. |
| Permanent          | To permanently retain documents, click Permanent. |

Inspect the policy

- If you want to view the options you set for the policy, in the Details column, click the Summary tab.

Protect the policy

- If you want to protect the policy, on the Edit menu, click Protect Policy.

  Note A user cannot modify or delete any documents under a protected policy.

Save the policy

- On the File menu, click Save.

  Note The policy remains inactive.

Assign the policy to a document type

1. On the File menu, click Assign and then perform the following substeps:
   1. In the <Policy Name>: Assignment dialog box, on the Document Type tab, click Add.
   2. In the Select Document Types dialog box, perform the following substeps:
      1. Optional. If the document type you want to assign does not appear under Search results, in the Search for document types box, type all or part of the document type name and then click Search.
      2. Under Search results, select one or more document types and then click Add. To select multiple document types, select the first type, hold down CTRL, and then click the remaining types.
      3. Click OK.
   2. Click OK.
Activate the policy

Note that after you activate a policy, you cannot modify the event rule, time rule, or disposition action set in that policy.

1. On the File menu, click Activate.
2. Close Retention Policy Designer.
Create advanced policies

An advanced policy can contain multiple phases or paths. When an advanced policy contains multiple phases, to allow documents to move from phase one to phase two and so on, at least one path in each phase must be set to a disposition action that is not final, such as online transfer or next phase. In addition, you must set all paths in the last phase to a final disposition action.

Create an advanced policy based on time and event

Follow this procedure to create a policy that contains multiple phases. A document enters a path in the phase when the event rule conditions are met. You define a time rule to determine the duration of the retention period. This section assumes you have created any needed document types and custom properties.

1. In Management Console, in the left pane, expand Retention.
2. Under Retention, click Policies.
3. In the right pane, on the Policies tab, click New. The Retention Policy Designer window opens.

Perform the following procedures in order.

Create the policy

1. In the New Policy dialog box, under Information, in the Name box, type a policy name, such as the record series name.
2. Optional. In the Identifier box, type an identifier, such as the record series code.
3. Optional. In the Description box, type a description of the documents included under this policy.
4. Select the Create advanced policy check box.
5. Optional. To assign a retention authority, such as an agency or regulatory body, with which the policy complies, under Authorities, click Add. In the Select Authorities dialog box, perform the following substeps:
   1. Optional. When the authority you want to assign does not appear under Search results, in the Search for authorities box, type all or part of an authority name and then click Search.
   2. Under Search results, select one or more authorities and then click Add. To select multiple authorities, select the first authority, hold down CTRL, and then click the remaining authorities.
   3. Click OK.
6. Click OK.

Create the first phase and path

1. In the New Phase dialog box, in the Name and Description boxes, type a phase name and descriptions and then click OK. The New Path dialog box appears.
2. In the New Path dialog box, in the Name and Description boxes, type a path name and description.
3. Click OK.
Create the path event rule

1. On the Event tab, click the Add button.
2. In the Add Condition dialog box, perform the following substeps:
   1. In the Constrain by list, click the kind of constraint that sets up the lists you need in the Type, Field, and Operator boxes.
   2. In the Type list, verify that Normal displays.
   3. In the Operator list, select an operator, such as "is equal to" or "is greater than," that is used in the comparison.
   4. In the Value box, select or type a value to be compared to the item, using the selected operator.
   5. Click OK.
3. To add more rule conditions, repeat the previous substeps.

Set the path time rule

- On the Time Period tab, in the Date type list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Type</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom property date</td>
<td>Click Custom property. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years. In the From list, to start the policy using a custom property date, select the date name.</td>
</tr>
<tr>
<td>Date period</td>
<td>Click Date period. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years. In the From list, select a date period. In the When list, to start the policy when the date period begins or ends, select Begin or End.</td>
</tr>
<tr>
<td>Event date</td>
<td>Click Event date. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years.</td>
</tr>
<tr>
<td>System date</td>
<td>Click System date. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years. In the From list, to start the policy using a system date, select Creation date, Last viewed date, or Last modified date.</td>
</tr>
</tbody>
</table>

Set action path approvers

This procedure is optional.

1. Click the Approvers tab.
2. Perform one of the following actions:
   - To assign users, click Add Users. In the Select Users dialog box, under Search results, select one or more users, click Add, and then click OK. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.
   - To assign a group, click Add Group. In the Select Group dialog box, under Search results, select a group and then click OK.
3. If you need additional levels of approval, click **Add Level** and then repeat the previous step.

4. Optional. In the **Instructions** box, type the instructions you want to display to all approvers when processing approval requests.

**Set the path disposition action**

- On the **Action** tab, in the **Select the action to perform** list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| **Accession**      | 1. Click **Accession**. In the **Select a removal method for documents after accession** list, perform one of the following actions:  
  - To retain the documents and associated metadata, click **None**.  
  - To delete the document and retain the associated metadata, click **Remove documents and retain metadata**.  
  2. In the **Select the physical location** list, select a physical location. |
| **Next phase**     | To move documents from an unprotected phase to a protected phase, click **Next phase**. |
| **Offline transfer** | To export and transfer documents to an offline location, click **Offline transfer** and in the **Select the physical location** list, select a physical location. |
| **Online transfer** | To transfer documents to a new OSM set that is available to the ImageNow Server, click **Online transfer**, and then in the **Select an OSM set** list, select an OSM set. |

**Create an additional phase and path**

1. On the **File** menu, point to **New** and then click **Phase**.

2. In the **New Phase** dialog box, in the **Name** and **Description** boxes, type a name and description and then click **OK**.

3. In the **New Path** dialog box, in the **Name** and **Description** boxes, type a name and description and then click **OK**.

4. To set the path details, in the **Details** column, perform one of the following procedures:

**Create a path based on an event with a time rule**

1. On the **Event** tab, click the **Add** button and then in the **Add Condition** dialog box, perform the following substeps:
   1. In the **Constrain by** list, click the kind of constraint that sets up the lists you need in the **Type**, **Field**, and **Operator** boxes.
   2. In the **Type** list, verify that **Normal** displays.
   3. In the **Operator** list, select an operator, such as "is equal to" or "is greater than," that is used in the comparison.
4. In the **Value** box, select or type a value to be compared to the item, using the selected operator.

5. Click **OK**.

6. To add more rule conditions, repeat the previous substeps.

2. Set the retention period

   - **On the Time Period tab**, in the **Date type** list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Type</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom property date</td>
<td>Click <strong>Custom property</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, to start the policy using a custom property date, select the date name.</td>
</tr>
<tr>
<td>Date period</td>
<td>Click <strong>Date period</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, to start the policy when the date period begins or ends, select <strong>Begin</strong> or <strong>End</strong>.</td>
</tr>
<tr>
<td>Event date</td>
<td>Click <strong>Event date</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years.</td>
</tr>
<tr>
<td>System date</td>
<td>Click <strong>System date</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, to start the policy using a system date, select <strong>Creation date</strong>, <strong>Last viewed date</strong>, or <strong>Last modified date</strong>.</td>
</tr>
</tbody>
</table>

3. Optional. Set action approvers

   1. Click the **Approvers** tab.

   2. Perform one of the following actions:

      - To assign users, click **Add Users**. In the **Select Users** dialog box, under **Search results**, select one or more users, click **Add**, and then click **OK**. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.

      - To assign a group, click **Add Group**. In the **Select Group** dialog box, under **Search results**, select a group and then click **OK**.

   3. If you need additional levels of approval, click **Add Level** and then repeat the previous step.

   4. Optional. In the **Instructions** box, type the instructions you want to display to all approvers when processing approval requests.
4. Set path disposition action
   - On the **Action** tab, in the **Select the action to perform** list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Accession          | 1. Click **Accession**. In the **Select a removal method for documents after accession** list, perform one of the following actions:  
  - To delete the documents and associated metadata, click **Delete documents and metadata**.  
  - To retain the documents and associated metadata, click **None**.  
  - To delete the document and retain the associated metadata, click **Remove documents and retain metadata**.  
  2. In the **Select the physical location** list, select a physical location. |
| Destruction        | To destroy documents, click **Destruction**. |
| Next phase         | To move documents from an unprotected phase to a protected phase, click **Next phase**. |
| Offline transfer   | To export and transfer documents to an offline location, click **Offline transfer** and in the **Select the physical location** list, select a physical location. |
| Online transfer    | To transfer documents to a new OSM set that is available to the ImageNow Server, click **Online transfer** and then in the **Select an OSM set** list, select an OSM set. |
| Permanent          | To permanently retain documents, click **Permanent**. |

5. Optional. To view the options you set for the path, in the **Details** column, click the **Summary** tab.

**Create a path based on an event rule**

1. To create an event rule, on the **Event** tab, click the **Add** button and then in the **Add Condition** dialog box, perform the following substeps:
   1. In the **Constrain by** list, click the kind of constraint that sets up the lists you need in the **Type**, **Field**, and **Operator** boxes.
   2. In the **Type** list, verify that **Normal** displays.
   3. In the **Operator** list, select an operator, such as "is equal to" or "is greater than," that is used in the comparison.
   4. In the **Value** box, select or type a value to be compared to the item, using the selected operator.
   5. Click **OK**.
   6. To add more rule conditions, repeat the previous substeps.
2. Specify when the disposition action occurs
   - On the **Time Period** tab, in the **Date type** list, perform one of the following actions:
     1. To set the disposition action to occur immediately, click **Immediate**.
     2. To set the disposition action to occur on a fixed date, click **Standard date** and in the **Date** list, in the calendar control, select a date.

3. Optional. Set action approvers
   1. Click the **Approvers** tab.
   2. Perform one of the following actions:
      - To assign users, click **Add Users**. In the **Select Users** dialog box, under **Search results**, select one or more users, click **Add**, and then click **OK**. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.
      - To assign a group, click **Add Group**. In the **Select Group** dialog box, under **Search results**, select a group and then click **OK**.
   3. If you need additional levels of approval, click **Add Level** and then repeat the previous step.

4. Optional. To modify the number of required approvers per level, complete the following substeps:
   1. In the **Levels** column, select a level and then click **Level Properties**.
   2. In the **Level Properties** dialog box, under **Required Approvals**, select from the following options:
      - To require all users associated with a level to complete an approval request, select **All users must approve**.
      - To choose a number of approvers associated with a level to complete an approval request, select **Select the number of users who must approve** and then select a number.

5. Optional. In the **Instructions** box, type the instructions you want to display to all approvers when processing approval requests.

4. Set path disposition action
   - To set the disposition action for documents in the selected path, under **Details**, on the **Action** tab, in the **Select the action to perform** list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Accession              | 1. Click **Accession**. In the **Select a removal method for documents after accession** list, perform one of the following actions:  
|                        |   • To delete the documents and associated metadata, click **Delete documents and metadata**.  
|                        |   • To retain the documents and associated metadata, click **None**.  
|                        |   • To delete the document and retain the associated metadata, click **Remove documents and retain metadata**.  
|                        | 2. In the **Select the physical location** list, select a physical location. |
Disposition Action | Steps
---|---
Destruction | To destroy documents, click **Destruction**.
Next phase | To move documents from an unprotected phase to a protected phase, click **Next phase**.
Offline transfer | To export and transfer documents to an offline location, click **Offline transfer** and in the Select the physical location list, select a physical location.
Online transfer | To transfer documents to a new OSM set that is available to the ImageNow Server, click **Online transfer**, and then in the Select an OSM set list, select an OSM set.
Permanent | To permanently retain documents, click **Permanent**.

5. Optional. To view the options you set for the path, in the **Details** column, click the **Summary** tab.

**Create a path based on a time rule**

1. Create the time rule and set the retention period
   - On the **Time Period** tab, in the **Date** type list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Type</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom property date</td>
<td>Click <strong>Custom property</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, to start the policy using a custom property date, select the date name.</td>
</tr>
<tr>
<td>Date period</td>
<td>Click <strong>Date period</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, select a date period. In the <strong>When</strong> list, to start the policy when the date period begins or ends, select <strong>Begin</strong> or <strong>End</strong>.</td>
</tr>
<tr>
<td>System date</td>
<td>Click <strong>System date</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, to start the policy using a system date, select <strong>Creation date</strong>, <strong>Last viewed date</strong>, or <strong>Last modified date</strong>.</td>
</tr>
</tbody>
</table>

2. Optional. Set action approvers
   1. Click the **Approvers** tab.
   2. Perform one of the following actions:
      - To assign users, click **Add Users**. In the **Select Users** dialog box, under **Search results**, select one or more users, click **Add**, and then click **OK**. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.
      - To assign a group, click **Add Group**. In the **Select Group** dialog box, under **Search results**, select a group and then click **OK**.
   3. If you need additional levels of approval, click **Add Level** and then repeat the previous step.
4. Optional. In the **Instructions** box, type the instructions you want to display to all approvers when processing approval requests.

5. Optional. To modify the number of required approvers per level, complete the following substeps:
   1. In the **Levels** column, select a level and then click **Level Properties**.
   2. In the **Level Properties** dialog box, under **Required Approvals**, select from the following options:
      - To require all users associated with a level to complete an approval request, select **All users must approve**.
      - To choose a number of approvers associated with a level to complete an approval request, select **Select the number of users who must approve** and then select a number.

3. Set the path disposition action
   - To set the disposition action for documents in the selected path, under **Details**, on the **Action** tab, in the **Select the action to perform** list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| **Accession**      | 1. Click **Accession**. In the **Select a removal method for documents after accession** list, perform one of the following actions:  
   - To delete the documents and associated metadata, click **Delete documents and metadata**.  
   - To retain the documents and associated metadata, click **None**.  
   - To delete the document and retain the associated metadata, click **Remove documents and retain metadata**.  
   2. In the **Select the physical location** list, select a physical location. |
| **Destruction**    | To destroy documents, click **Destruction**. |
| **Next phase**     | To move documents from an unprotected phase to a protected phase, click **Next phase**. |
| **Offline transfer** | To export and transfer documents to an offline location, click **Offline transfer** and in the **Select the physical location** list, select a physical location. |
| **Online transfer** | To transfer documents to a new OSM set that is available to the ImageNow Server, click **Online transfer**, and then in the **Select an OSM set** list, select an OSM set. |
| **Permanent**      | To permanently retain documents, click **Permanent**. |
Inspect the policy

- If you want to view the options you set for the policy, in the Details column, click the Summary tab.

Protect a phase

- To protect a phase in the policy, in the Phases column, click the phase and then on the Edit menu, click Protect Selected Phase.
  
  Note A user cannot modify or delete any documents under a protected phase.

Save the policy

- On the File menu, click Save.
  
  Note The policy remains inactive.

Assign the policy to a document type

1. On the File menu, click Assign and then perform the following substeps:
   1. In the <Policy Name>: Assignment dialog box, on the Document Type tab, click Add.
   2. In the Select Document Types dialog box, perform the following substeps:
      1. Optional. If the document type you want to assign does not appear under Search results, in the Search for document types box, type all or part of the document type name and then click Search.
      2. Under Search results, select one or more document types and then click Add. To select multiple document types, select the first type, hold down CTRL, and then click the remaining types.
      3. Click OK.
   2. Click OK.

Activate the policy

Note that after you activate a policy, you cannot modify the event rule, time rule, or disposition action set in that policy.

1. On the File menu, click Activate.
2. Close Retention Policy Designer.

Create an advanced policy based on an event

Follow this procedure to create a policy that contains multiple phases. A document enters a path in the phase when the event rule conditions are met. You define a time rule to determine the duration of the retention period. This section assumes you have created any needed document types and custom properties.

1. In Management Console, in the left pane, expand Retention.
2. Under Retention, click Policies.
3. In the right pane, on the Policies tab, click New. The Retention Policy Designer window opens. Perform the following procedures in order.
Create the policy
1. In the **New Policy** dialog box, under **Information**, in the **Name** box, type a policy name, such as the record series name.
2. Optional. In the **Identifier** box, type an identifier, such as the record series code.
3. Optional. In the **Description** box, type a description of the documents included under this policy.
4. Select the **Create advanced policy** check box.
5. Optional. To assign a retention authority, such as an agency or regulatory body, with which the policy complies, under **Authorities**, click **Add**. In the **Select Authorities** dialog box, perform the following substeps:
   1. Optional. When the authority you want to assign does not appear under **Search results**, in the **Search for authorities** box, type all or part of an authority name and then click **Search**.
   2. Under **Search results**, select one or more authorities and then click **Add**. To select multiple authorities, select the first authority, hold down CTRL, and then click the remaining authorities.
   3. Click **OK**.
6. Click **OK**.

Create the first phase and path
1. In the **New Phase** dialog box, in the **Name** and **Description** boxes, type a phase name and descriptions and then click **OK**. The **New Path** dialog box appears.
2. In the **New Path** dialog box, in the **Name** and **Description** boxes, type a path name and description.
3. Click **OK**.

Create the path event rule
1. On the **Event** tab, click the **Add** button.
2. In the **Add Condition** dialog box, perform the following substeps:
   1. In the **Constrain by** list, click the kind of constraint that sets up the lists you need in the **Type**, **Field**, and **Operator** boxes.
   2. In the **Type** list, verify that **Normal** displays.
   3. In the **Operator** list, select an operator, such as "is equal to" or "is greater than," that is used in the comparison.
   4. In the **Value** box, select or type a value to be compared to the item, using the selected operator.
   5. Click **OK**.
3. To add more rule conditions, repeat the previous substeps.

Set the path time rule
- On the **Time Period** tab, in the **Date type** list, perform one of the following actions:
  - To set the disposition action to occur immediately, click **Immediate**.
  - To set the disposition action to occur on a fixed date, click **Standard date** and in the **Date** list, in the calendar control, select a date.
Set action path approvers

This procedure is optional.

1. Click the Approvers tab.
2. Perform one of the following actions:
   - To assign users, click Add Users. In the Select Users dialog box, under Search results, select one or more users, click Add, and then click OK. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.
   - To assign a group, click Add Group. In the Select Group dialog box, under Search results, select a group and then click OK.
3. If you need additional levels of approval, click Add Level and then repeat the previous step.
4. Optional. In the Instructions box, type the instructions you want to display to all approvers when processing approval requests.

Set the path disposition action

- On the Action tab, in the Select the action to perform list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| **Accession**      | 1. Click Accession. In the Select a removal method for documents after accession list, perform one of the following actions:  
|                    | - To retain the documents and associated metadata, click None.  
|                    | - To delete the document and retain the associated metadata, click Remove documents and retain metadata.  
|                    | 2. In the Select the physical location list, select a physical location. |
| **Next phase**     | To move documents from an unprotected phase to a protected phase, click Next phase. |
| **Offline transfer** | To export and transfer documents to an offline location, click Offline transfer and in the Select the physical location list, select a physical location. |
| **Online transfer** | To transfer documents to a new OSM set that is available to the ImageNow Server, click Online transfer, and then in the Select an OSM set list, select an OSM set. |

Create an additional phase and path

1. On the File menu, point to New and then click Phase.
2. In the New Phase dialog box, in the Name and Description boxes, type a name and description and then click OK.
3. In the **New Path** dialog box, in the **Name** and **Description** boxes, type a name and description and then click **OK**.

4. To set the path details, in the **Details** column, perform one of the following procedures:

**Create a path based on an event with a time rule**

1. On the **Event** tab, click the **Add** button and then in the **Add Condition** dialog box, perform the following substeps:
   1. In the **Constrain by** list, click the kind of constraint that sets up the lists you need in the **Type**, **Field**, and **Operator** boxes.
   2. In the **Type** list, verify that **Normal** displays.
   3. In the **Operator** list, select an operator, such as "is equal to" or "is greater than," that is used in the comparison.
   4. In the **Value** box, select or type a value to be compared to the item, using the selected operator.
   5. Click **OK**.
   6. To add more rule conditions, repeat the previous substeps.

2. Set the retention period
   - On the **Time Period** tab, in the **Date type** list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Type</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom property date</td>
<td>Click <strong>Custom property</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, to start the policy using a custom property date, select the date name.</td>
</tr>
<tr>
<td>Date period</td>
<td>Click <strong>Date period</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, select a date period. In the <strong>When</strong> list, to start the policy when the date period begins or ends, select <strong>Begin</strong> or <strong>End</strong>.</td>
</tr>
<tr>
<td>Event date</td>
<td>Click <strong>Event date</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years.</td>
</tr>
<tr>
<td>System date</td>
<td>Click <strong>System date</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, to start the policy using a system date, select <strong>Creation date</strong>, <strong>Last viewed date</strong>, or <strong>Last modified date</strong>.</td>
</tr>
</tbody>
</table>

3. Optional. Set action approvers
   1. Click the **Approvers** tab.
   2. Perform one of the following actions:
      - To assign users, click **Add Users**. In the **Select Users** dialog box, under **Search results**, select one or more users, click **Add**, and then click **OK**. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.
      - To assign a group, click **Add Group**. In the **Select Group** dialog box, under **Search results**, select a group and then click **OK**.
3. If you need additional levels of approval, click **Add Level** and then repeat the previous step.

4. Optional. In the **Instructions** box, type the instructions you want to display to all approvers when processing approval requests.

4. Set path disposition action
   - On the **Action** tab, in the **Select the action to perform** list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Accession          | 1. Click **Accession**. In the **Select a removal method for documents after accession** list, perform one of the following actions:  
|                    | • To delete the documents and associated metadata, click **Delete documents and metadata**.  
|                    | • To retain the documents and associated metadata, click **None**.  
|                    | • To delete the document and retain the associated metadata, click **Remove documents and retain metadata**.  
|                    | 2. In the **Select the physical location** list, select a physical location. |
| Destruction        | To destroy documents, click **Destruction**. |
| Next phase         | To move documents from an unprotected phase to a protected phase, click **Next phase**. |
| Offline transfer   | To export and transfer documents to an offline location, click **Offline transfer** and in the **Select the physical location** list, select a physical location. |
| Online transfer    | To transfer documents to a new OSM set that is available to the ImageNow Server, click **Online transfer**, and then in the **Select an OSM set** list, select an OSM set. |
| Permanent          | To permanently retain documents, click **Permanent**. |

5. Optional. To view the options you set for the path, in the **Details** column, click the **Summary** tab.

**Create a path based on an event rule**

1. On the **Event** tab, click the **Add** button and then in the **Add Condition** dialog box, perform the following substeps:
   1. In the **Constrain by** list, click the kind of constraint that sets up the lists you need in the **Type**, **Field**, and **Operator** boxes.
   2. In the **Type** list, verify that **Normal** displays.
   3. In the **Operator** list, select an operator, such as "is equal to" or "is greater than," that is used in the comparison.
   4. In the **Value** box, select or type a value to be compared to the item, using the selected operator.
5. Click OK.

6. To add more rule conditions, repeat the previous substeps.

2. Specify when the disposition action occurs

- On the Time Period tab, in the Date type list, perform one of the following actions:
  1. To set the disposition action to occur immediately, click Immediate.
  2. To set the disposition action to occur on a fixed date, click Standard date and in the Date list, in the calendar control, select a date.

3. Optional. Set action approvers

1. Click the Approvers tab.

2. Perform one of the following actions:

- To assign users, click Add Users. In the Select Users dialog box, under Search results, select one or more users, click Add, and then click OK. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.

- To assign a group, click Add Group. In the Select Group dialog box, under Search results, select a group and then click OK.

3. If you need additional levels of approval, click Add Level and then repeat the previous step.

4. Optional. In the Instructions box, type the instructions you want to display to all approvers when processing approval requests.

4. Set path disposition action

- To set the disposition action for documents in the selected path, under Details, on the Action tab, in the Select the action to perform list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Accession          | 1. Click Accession. In the Select a removal method for documents after accession list, perform one of the following actions:  
  • To delete the documents and associated metadata, click Delete documents and metadata.  
  • To retain the documents and associated metadata, click None.  
  • To delete the document and retain the associated metadata, click Remove documents and retain metadata.  
  2. In the Select the physical location list, select a physical location. |
| Destruction        | To destroy documents, click Destruction. |
| Next phase         | To move documents from an unprotected phase to a protected phase, click Next phase. |
| Offline transfer   | To export and transfer documents to an offline location, click Offline transfer and in the Select the physical location list, select a physical location. |
### Disposition Action

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online transfer</td>
<td>To transfer documents to a new OSM set that is available to the ImageNow Server, click <strong>Online transfer</strong>, and then in the <strong>Select an OSM set</strong> list, select an OSM set.</td>
</tr>
<tr>
<td>Permanent</td>
<td>To permanently retain documents, click <strong>Permanent</strong>.</td>
</tr>
</tbody>
</table>

5. Optional. To view the options you set for the path, in the **Details** column, click the **Summary** tab.

### Create a path based on a time rule

1. Create the time rule and set the retention period
   - On the **Time Period** tab, in the **Date** type list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Type</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom property date</td>
<td>Click <strong>Custom property</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, to start the policy using a custom property date, select the date name.</td>
</tr>
<tr>
<td>Date period</td>
<td>Click <strong>Date period</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, select a date period. In the <strong>When</strong> list, to start the policy when the date period begins or ends, select <strong>Begin</strong> or <strong>End</strong>.</td>
</tr>
<tr>
<td>System date</td>
<td>Click <strong>System date</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, to start the policy using a system date, select <strong>Creation date</strong>, <strong>Last viewed date</strong>, or <strong>Last modified date</strong>.</td>
</tr>
</tbody>
</table>

2. Optional. Set action approvers
   1. Click the **Approvers** tab.
   2. Perform one of the following actions:
      - To assign users, click **Add Users**. In the **Select Users** dialog box, under **Search results**, select one or more users, click **Add**, and then click **OK**. To select multiple users, select the first user, hold down **CTRL**, and then click the remaining users.
      - To assign a group, click **Add Group**. In the **Select Group** dialog box, under **Search results**, select a group and then click **OK**.
   3. If you need additional levels of approval, click **Add Level** and then repeat the previous step.
   4. Optional. In the **Instructions** box, type the instructions you want to display to all approvers when processing approval requests.
5. Optional. To modify the number of required approvers per level, complete the following substeps:

1. In the **Levels** column, select a level and then click **Level Properties**.

2. In the **Level Properties** dialog box, under Required Approvals, select from the following options:
   - To require all users associated with a level to complete an approval request, select **All users must approve**.
   - To choose a number of approvers associated with a level to complete an approval request, select **Select the number of users who must approve** and then select a number.

3. Set the path disposition action
   - On the **Action** tab, in the **Select the action to perform** list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| **Accession**      | 1. Click **Accession**. In the **Select a removal method for documents after accession** list, perform one of the following actions:  
  - To delete the documents and associated metadata, click **Delete documents and metadata**.  
  - To retain the documents and associated metadata, click **None**.  
  - To delete the document and retain the associated metadata, click **Remove documents and retain metadata**.  
  2. In the **Select the physical location** list, select a physical location. |
| **Destruction**    | To destroy documents, click **Destruction**. |
| **Next phase**     | To move documents from an unprotected phase to a protected phase, click **Next phase**. |
| **Offline transfer** | To export and transfer documents to an offline location, click **Offline transfer** and in the **Select the physical location** list, select a physical location. |
| **Online transfer** | To transfer documents to a new OSM set that is available to the ImageNow Server, click **Online transfer**, and then in the **Select an OSM set** list, select an OSM set. |
| **Permanent**      | To permanently retain documents, click **Permanent**. |
Inspect the policy

- If you want to view the options you set for the policy, in the Details column, click the Summary tab.

Protect a phase

- To protect a phase in the policy, in the Phases column, click the phase and then on the Edit menu, click Protect Selected Phase.
  
  Note A user cannot modify or delete any documents under a protected phase.

Save the policy

- On the File menu, click Save.
  
  Note The policy remains inactive.

Assign the policy to a document type

1. On the File menu, click Assign and then perform the following substeps:
   1. In the <Policy Name>: Assignment dialog box, on the Document Type tab, click Add.
   2. In the Select Document Types dialog box, perform the following substeps:
      1. Optional. If the document type you want to assign does not appear under Search results, in the Search for document types box, type all or part of the document type name and then click Search.
      2. Under Search results, select one or more document types and then click Add. To select multiple document types, select the first type, hold down CTRL, and then click the remaining types.
      3. Click OK.
  2. Click OK.

Activate the policy

Note that after you activate a policy, you cannot modify the event rule, time rule, or disposition action set in that policy.

1. On the File menu, click Activate.
2. Close Retention Policy Designer.

Create an advanced policy based on a time

Follow this procedure to create a policy that contains multiple phases. A document enters a path in the phase when the time rule conditions are met. You also use the time rule to determine the duration of the retention period. This section assumes you have created any needed document types and custom properties.

1. In Management Console, in the left pane, expand Retention.
2. Under Retention, click Policies.
3. In the right pane, on the Policies tab, click New. The Retention Policy Designer window opens. Perform the following procedures in order.
Create the policy

1. In the New Policy dialog box, under Information, in the Name box, type a policy name, such as the record series name.

2. Optional. In the Identifier box, type an identifier, such as the record series code.

3. Optional. In the Description box, type a description of the documents included under this policy.

4. Select the Create advanced policy check box.

5. Optional. To assign a retention authority, such as an agency or regulatory body, with which the policy complies, under Authorities, click Add. In the Select Authorities dialog box, perform the following substeps:
   1. Optional. When the authority you want to assign does not appear under Search results, in the Search for authorities box, type all or part of an authority name and then click Search.
   2. Under Search results, select one or more authorities and then click Add. To select multiple authorities, select the first authority, hold down CTRL, and then click the remaining authorities.
   3. Click OK.

6. Click OK.

Create the first phase and path

1. In the New Phase dialog box, in the Name and Description boxes, type a phase name and descriptions and then click OK. The New Path dialog box appears.

2. In the New Path dialog box, in the Name and Description boxes, type a path name and description.

3. Click OK.

Create the path time rule

- On the Time Period tab, in the Date type list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Type</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom property date</td>
<td>Click Custom property. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years. In the From list, to start the policy using a custom property date, select the date name.</td>
</tr>
<tr>
<td>Date period</td>
<td>Click Date period. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years. In the From list, select a date period. In the When list, to start the policy when the date period begins or ends, select Begin or End.</td>
</tr>
<tr>
<td>System date</td>
<td>Click System date. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years. In the From list, to start the policy using a system date, select Creation date, Last viewed date, or Last modified date.</td>
</tr>
</tbody>
</table>
Set action path approvers

This procedure is optional.

1. Click the Approvers tab.
2. Perform one of the following actions:
   - To assign users, click Add Users. In the Select Users dialog box, under Search results, select one or more users, click Add, and then click OK. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.
   - To assign a group, click Add Group. In the Select Group dialog box, under Search results, select a group and then click OK.
3. If you need additional levels of approval, click Add Level and then repeat the previous step.
4. Optional. In the Instructions box, type the instructions you want to display to all approvers when processing approval requests.

Set path disposition action

- On the Action tab, in the Select the action to perform list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Accession          | 1. Click Accession. In the Select a removal method for documents after accession list, perform one of the following actions:  
   - To delete the documents and associated metadata, click Delete documents and metadata.  
   - To retain the documents and associated metadata, click None.  
   - To delete the document and retain the associated metadata, click Remove documents and retain metadata.  
   2. In the Select the physical location list, select a physical location. |
| Destruction        | To destroy documents, click Destruction. |
| Next phase         | To move documents from an unprotected phase to a protected phase, click Next phase. |
| Offline transfer   | To export and transfer documents to an offline location, click Offline transfer and in the Select the physical location list, select a physical location. |
| Online transfer    | To transfer documents to a new OSM set that is available to the ImageNow Server, click Online transfer, and then in the Select an OSM set list, select an OSM set. |
| Permanent          | To permanently retain documents, click Permanent. |
Create an additional phase and path

1. On the File menu, point to New and then click Phase.
2. In the New Phase dialog box, in the Name and Description boxes, type a name and description and then click OK.
3. In the New Path dialog box, in the Name and Description boxes, type a name and description and then click OK.
4. To set the path details, in the Details column, perform one of the following procedures:

Create a path based on an event with a time rule

1. On the Event tab, click the Add button and then in the Add Condition dialog box, perform the following substeps:
   1. In the Constrain by list, click the kind of constraint that sets up the lists you need in the Type, Field, and Operator boxes.
   2. In the Type list, verify that Normal displays.
   3. In the Operator list, select an operator, such as "is equal to" or "is greater than," that is used in the comparison.
   4. In the Value box, select or type a value to be compared to the item, using the selected operator.
   5. Click OK.
   6. To add more rule conditions, repeat the previous substeps.
2. Set the retention period
   • On the Time Period tab, in the Date type list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Type</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom property date</td>
<td>Click Custom property. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years. In the From list, to start the policy using a custom property date, select the date name.</td>
</tr>
<tr>
<td>Date period</td>
<td>Click Date period. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years. In the From list, select a date period. In the When list, to start the policy when the date period begins or ends, select Begin or End.</td>
</tr>
<tr>
<td>Event date</td>
<td>Click Event date. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years.</td>
</tr>
<tr>
<td>System date</td>
<td>Click System date. In the Number box, type an integer. In the Period list, select a duration, such as weeks or years. In the From list, to start the policy using a system date, select Creation date, Last viewed date, or Last modified date.</td>
</tr>
</tbody>
</table>
3. Optional. Set action approvers
   
   1. Click the **Approvers** tab.
   
   2. Perform one of the following actions:
      
      - To assign users, click **Add Users**. In the **Select Users** dialog box, under **Search results**, select one or more users, click **Add**, and then click **OK**. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.
      
      - To assign a group, click **Add Group**. In the **Select Group** dialog box, under **Search results**, select a group and then click **OK**.
   
   3. If you need additional levels of approval, click **Add Level** and then repeat the previous step.
   
   4. Optional. In the **Instructions** box, type the instructions you want to display to all approvers when processing approval requests.

4. Set path disposition action
   
   - On the **Action** tab, in the **Select the action to perform** list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Accession         | 1. Click **Accession**. In the **Select a removal method for documents after accession** list, perform one of the following actions:  
   
      - To delete the documents and associated metadata, click **Delete documents and metadata**.  
      
      - To retain the documents and associated metadata, click **None**.  
      
      - To delete the document and retain the associated metadata, click **Remove documents and retain metadata**.  
   
   2. In the **Select the physical location** list, select a physical location. |
| Destruction        | To destroy documents, click **Destruction**. |
| Next phase         | To move documents from an unprotected phase to a protected phase, click **Next phase**. |
| Offline transfer   | To export and transfer documents to an offline location, click **Offline transfer** and in the **Select the physical location** list, select a physical location. |
| Online transfer    | To transfer documents to a new OSM set that is available to the ImageNow Server, click **Online transfer**, and then in the **Select an OSM set** list, select an OSM set. |
| Permanent          | To permanently retain documents, click **Permanent**. |

5. Optional. To view the options you set for the path, in the **Details** column, click the **Summary** tab.
Create a path based on an event rule

1. On the Event tab, click the Add button and then in the Add Condition dialog box, perform the following substeps:
   1. In the Constrain by list, click the kind of constraint that sets up the lists you need in the Type, Field, and Operator boxes.
   2. In the Type list, verify that Normal displays.
   3. In the Operator list, select an operator, such as "is equal to" or "is greater than," that is used in the comparison.
   4. In the Value box, select or type a value to be compared to the item, using the selected operator.
   5. Click OK.
   6. To add more rule conditions, repeat the previous substeps.

2. Specify when the disposition action occurs
   • On the Time Period tab, in the Date type list, perform one of the following actions:
     1. To set the disposition action to occur immediately, click Immediate.
     2. To set the disposition action to occur on a fixed date, click Standard date and in the Date list, in the calendar control, select a date.

3. Optional. Set action approvers
   1. Click the Approvers tab.
   2. Perform one of the following actions:
      • To assign users, click Add Users. In the Select Users dialog box, under Search results, select one or more users, click Add, and then click OK. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.
      • To assign a group, click Add Group. In the Select Group dialog box, under Search results, select a group and then click OK.
   3. If you need additional levels of approval, click Add Level and then repeat the previous step.
   4. Optional. In the Instructions box, type the instructions you want to display to all approvers when processing approval requests.
   5. Optional. To modify the number of required approvers per level, complete the following substeps:
      1. In the Levels column, select a level and then click Level Properties.
      2. In the Level Properties dialog box, under Required Approvals, select from the following options:
         • To require all users associated with a level to complete an approval request, select All users must approve.
         • To choose a number of approvers associated with a level to complete an approval request, select Select the number of users who must approve and then select a number.
4. Set path disposition action
   - To set the disposition action for documents in the selected path, under **Details**, on the **Action** tab, in the **Select the action to perform** list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Accession          | 1. Click **Accession**. In the **Select a removal method for documents after accession** list, perform one of the following actions:  
   - To delete the documents and associated metadata, click **Delete documents and metadata**.  
   - To retain the documents and associated metadata, click **None**.  
   - To delete the document and retain the associated metadata, click **Remove documents and retain metadata**.  
  2. In the **Select the physical location** list, select a physical location. |
| Destruction        | To destroy documents, click **Destruction**. |
| Next phase         | To move documents from an unprotected phase to a protected phase, click **Next phase**. |
| Offline transfer   | To export and transfer documents to an offline location, click **Offline transfer** and in the **Select the physical location** list, select a physical location. |
| Online transfer    | To transfer documents to a new OSM set that is available to the ImageNow Server, click **Online transfer**, and then in the **Select an OSM set** list, select an OSM set. |
| Permanent          | To permanently retain documents, click **Permanent**. |

5. Optional. To view the options you set for the path, in the **Details** column, click the **Summary** tab.
Create a path based on a time rule

1. Create the time rule and set the retention period

   • On the **Time Period** tab, in the **Date** type list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Type</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom property date</td>
<td>Click <strong>Custom property</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, to start the policy using a custom property date, select the date name.</td>
</tr>
<tr>
<td>Date period</td>
<td>Click <strong>Date period</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, select a date period. In the <strong>When</strong> list, to start the policy when the date period begins or ends, select <strong>Begin</strong> or <strong>End</strong>.</td>
</tr>
<tr>
<td>System date</td>
<td>Click <strong>System date</strong>. In the <strong>Number</strong> box, type an integer. In the <strong>Period</strong> list, select a duration, such as weeks or years. In the <strong>From</strong> list, to start the policy using a system date, select <strong>Creation date</strong>, <strong>Last viewed date</strong>, or <strong>Last modified date</strong>.</td>
</tr>
</tbody>
</table>

2. Optional. Set action approvers

   1. Click the **Approvers** tab.
   2. Perform one of the following actions:

      • To assign users, click **Add Users**. In the **Select Users** dialog box, under **Search results**, select one or more users, click **Add**, and then click **OK**. To select multiple users, select the first user, hold down CTRL, and then click the remaining users.

      • To assign a group, click **Add Group**. In the **Select Group** dialog box, under **Search results**, select a group and then click **OK**.

   3. If you need additional levels of approval, click **Add Level** and then repeat the previous step.
   4. Optional. In the **Instructions** box, type the instructions you want to display to all approvers when processing approval requests.
   5. Optional. To modify the number of required approvers per level, complete the following substeps:

      1. In the **Levels** column, select a level and then click **Level Properties**.
      2. In the **Level Properties** dialog box, under **Required Approvals**, select from the following options:

         • To require all users associated with a level to complete an approval request, select **All users must approve**.
         • To choose a number of approvers associated with a level to complete an approval request, select **Select the number of users who must approve** and then select a number.
3. Set the path disposition action
   - On the **Action** tab, in the **Select the action to perform** list, perform one of the following actions:

<table>
<thead>
<tr>
<th>Disposition Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Accession          | 1. Click **Accession**. In the **Select a removal method for documents after accession** list, perform one of the following actions:  
   - To delete the documents and associated metadata, click **Delete documents and metadata**.  
   - To retain the documents and associated metadata, click **None**.  
   - To delete the document and retain the associated metadata, click **Remove documents and retain metadata**.  
   2. In the **Select the physical location** list, select a physical location. |
| Destruction        | To destroy documents, click **Destruction**. |
| Next phase         | To move documents from an unprotected phase to a protected phase, click **Next phase**. |
| Offline transfer   | To export and transfer documents to an offline location, click **Offline transfer** and in the **Select the physical location** list, select a physical location. |
| Online transfer    | To transfer documents to a new OSM set that is available to the ImageNow Server, click **Online transfer**, and then in the **Select an OSM set** list, select an OSM set. |
| Permanent          | To permanently retain documents, click **Permanent**. |

**Inspect the policy**
- If you want to view the options you set for the policy, in the **Details** column, click the **Summary** tab.

**Protect a phase**
- To protect a phase in the policy, in the **Phases** column, click the phase and then on the **Edit** menu, click **Protect Selected Phase**.  
  Note A user cannot modify or delete any documents under a protected phase.

**Save the policy**
- On the **File** menu, click **Save**.  
  Note The policy remains inactive.
Assign the policy to a document type

1. On the File menu, click Assign and then perform the following substeps:
   1. In the <Policy Name>: Assignment dialog box, on the Document Type tab, click Add.
   2. In the Select Document Types dialog box, perform the following substeps:
      1. Optional. If the document type you want to assign does not appear under Search results, in the Search for document types box, type all or part of the document type name and then click Search.
      2. Under Search results, select one or more document types and then click Add. To select multiple document types, select the first type, hold down CTRL, and then click the remaining types.
      3. Click OK.

2. Click OK.

Activate the policy

Note that after you activate a policy, you cannot modify the event rule, time rule, or disposition action set in that policy.

1. On the File menu, click Activate.
2. Close Retention Policy Designer.
Retention sets

Retention Policy Manager provides sets so you can manage the documents you need to destroy, accession, or transfer offline after the retention period ends.

About destruction sets

Retention Policy Manager creates destruction sets for the documents that are designated for destruction and are associated with physical file references. When the retention period ends, instead of destroying the documents that fall under a policy, Retention Policy Manager creates a destruction set for those documents. Documents that are designated for destruction but do not have associated physical file references are automatically destroyed when the retention period ends and do not appear in retention sets.

Retention Policy Manager provides a report for each destruction set. This report lists each document in the destruction set and the physical file reference for that document. You can use the report information to determine the physical documents that you or your storage facility need to destroy.

After the physical documents are destroyed, you confirm the destruction set. When you confirm the destruction set, Retention Policy Manager prompts you to confirm the date the physical documents were destroyed, the name of the individual who destroyed them, and the destruction method.

Generate a destruction set report

The following procedure assumes the corresponding retention period has ended and that there are documents under the policy that have physical file references. To perform this procedure, you must have the global Manage Retention Policies privilege. The system generates destruction set reports in CVS format.

1. On the ImageNow toolbar, click Manage.
2. In the Management Console, in the left pane, expand Retention and then click Sets.
3. In the right pane, on the Destruction tab, select a retention set and then do the following substeps:
   1. Click Report.
   2. In the Save As dialog box, enter a name for the report and then navigate to the location where you want to save the report.
   3. Click Save.
4. To view the report, in Windows Explorer, navigate to the location you chose to save the report. Then, open the CSV file in any application that supports that type of file, including Microsoft Excel or a text editor.

Confirm a destruction set

To perform this procedure, you must have the global Manage Retention Policies privilege. Follow this procedure to remove the documents and metadata associated with a destruction set from your system. You perform this procedure only after you destroy the physical documents in the set.

1. On the ImageNow toolbar, click Manage.
2. In the Management Console, in the left pane, expand Retention and then click Sets.
3. In the right pane, on the Destruction tab, select the appropriate set and then click Destroy.
4. In the **Confirm Set Destruction** dialog box, enter the following physical destruction properties:
   - In the **Date** box, type the date of the destruction or select a date from the calendar control.
   - In the **Name** box, type the name of the individual who performed the destruction.
   - In the **Method** box, type a description of the destruction method.

5. Click **OK**.

### About export sets

Retention Policy Manager uses export sets to transfer documents to a physical location when the path disposition action is accession, offline transfer, or when you export a hold. After the retention period ends, instead of exporting one document at a time, the system creates an export set for the documents in the path. After the export set is complete, that set is exported to the physical location defined for the path. The amount of time it takes to create and export a set depends on the number of documents in that set.

To create an export set, Retention Policy Manager converts each document that falls under a path to an XML file that meets DoD (Department of Defense) 5015.02 standards. Each XML file contains the document image file and associated metadata, such as document keys and keywords. When a document contains multiple pages, the system creates a separate XML file for each page in that document. In addition to the XML files, the system creates a CSV file for each export set. The CSV file contains information that is specific to the export set. This information is available to you when you run an export set report.

Accession and offline transfer export sets appear in the Sets area of Retention Policy Manager. From this location, you can view the status and location of all export sets, run reports, and confirm that the documents were exported to the designated physical location. If an export is unsuccessful, Retention Policy Manager allows you to initiate the export process again. After you confirm the export set and enter the new location of the physical documents, Retention Policy Manager uses the path disposition action to determine what actions to perform on the documents and metadata that reside in your ImageNow system.

When the disposition action is offline transfer, the system removes the document pages and leaves the metadata intact. If the disposition action is accession, the system uses the removal method defined for the path to determine whether to remove or retain the document pages and metadata in your system.

When you export a hold, Retention Policy Manager creates an export set for the documents under that hold. To export a hold, you select the hold, define the document file format, such as PDF or TIFF, and set the physical location. After the system converts a copy of each document in the set to the format you select, Retention Policy Manager exports that set to the designated physical location. Retention Policy Manager also exports a CSV file for each export from hold set. You can view the information in this file using a set report. The amount of time it takes to create and export a set depends on the number of documents under the selected hold.

### Generate an export set report

To perform this procedure, you must have the global Manage Retention Policies privilege. Using these steps, you create a report in CSV format.

1. On the **ImageNow** toolbar, click **Manage**.
2. In the **Management Console**, in the left pane, expand **Retention** and then click **Sets**.
3. In the right pane, on the **Export** tab, select a retention set and then do the following substeps:
   
   1. Click **Report**.
   
   2. In the **Save As** dialog box, enter a name for the report and then navigate to the location where you want to save the report.
   
   3. Click **Save**.
   
   4. To view the report, in **Windows Explorer**, navigate to the location you chose to save the report. Then, open the CSV file in any application that supports that type of file, including Microsoft Excel or a text editor.

**Confirm an export set**

To perform this procedure, you must have the global Manage Retention Policies privilege. Using these steps, you can confirm that an export is complete.

   1. On the **ImageNow** toolbar, click **Manage**.
   
   2. In the **Management Console**, in the left pane, expand **Retention** and then click **Sets**.
   
   3. In the right pane, on the **Export** tab, select the appropriate set and then click **Confirm**.
   
   4. In the **Confirm Set Export** dialog box, to update the location of the exported files, enter the new physical reference properties and then click **OK**.

**About move and copy sets**

Retention Policy Manager provides move and copy sets so you can manage the accession or offline transfer of your physical documents. When documents are associated with a physical file reference and the disposition action for the path is accession or offline transfer, the system automatically creates a move or copy set. Each set type contains a CSV file. This file lists the document keys for each document and the current offline physical location. To access the CSV file, you run a set report.

Retention Policy Manager creates a separate set for each physical file reference and uses the disposition action to determine the set type. When the path disposition action is offline transfer (not final), Retention Policy Manager creates a move set. After you move the physical documents to a new physical location, you can confirm the move set. When you confirm an offline move set, the system prompts you to enter the new location of your physical documents. After you confirm the move set for this disposition action, the documents in that set move to the next phase in the policy.

If the path disposition method is accession, the removal method determines the type of set the system creates. When the method removes the document pages, but retains the metadata (not final), the system creates a move set. Retention Policy Manager also creates a move set when the removal method deletes both the documents and metadata (final). After you accession the physical documents, you can confirm the move set. When you confirm a move set, Retention Policy Manager prompts you to enter the new physical location of those physical documents. After you confirm a move set for the removal methods described here, the documents in that set move to an export set.

When the accession removal method retains the documents and metadata (not final), Retention Policy Manager creates a copy set. After you copy the physical documents so that you can accession them, you confirm the copy set. Because the documents and metadata remain in the system, Retention Policy Manager does not prompt you to enter the physical location of the copies. After you confirm a copy set, the documents in that set enter the next phase in the retention policy.
Generate a move set report or a copy set report

To perform this procedure, you must have the global Manage Retention Policies privilege. Using these steps, you create a report in CSV format.

1. On the ImageNow toolbar, click Manage.
2. In the Management Console, in the left pane, expand Retention and then click Sets.
3. In the right pane, on the Move and Copy tab, select a retention set and then do the following substeps:
   1. Click Report.
   2. In the Save As dialog box, enter a name for the report and then navigate to the location where you want to save the report.
   3. Click Save.
4. To view the report, in Windows Explorer, navigate to the location you chose to save the report. Then, open the CSV file in any application that supports that type of file, including Microsoft Excel or a text editor.

Confirm a move or copy set

To perform this procedure, you must have the global Manage Retention Policies privilege. Using these steps, you confirm that the physical documents have been moved to a new physical location or that a copy exists so that you can accession the physical documents.

1. On the ImageNow toolbar, click Manage.
2. In the Management Console, in the left pane, expand Retention and then click Sets.
3. In the right pane, on the Move and Copy tab, select the appropriate set and then click Confirm.
4. In the Confirm Move Set or Confirm Copy Set dialog box, to update the location of the exported files, enter the new physical reference properties and then click OK.
   
   **Note** You enter a new physical reference property for move sets only.
About holds

A hold allows you to preserve a document. No user can modify or delete a document under a hold. A document under hold can also be under a retention policy but does not need to be under a policy. You can apply a hold for a specific period of time or indefinitely. Retention Policy Manager provides two types of holds: permanent and absolute expiration. A permanent hold type is indefinite and applied until you remove it. The absolute expiration hold type requires an end date and expires on the date you select.

You can apply a hold at the document type (inherited) or document (direct) level. To assign an inherited hold, assign a document type when you create the hold. All documents indexed with that document type are automatically placed under the hold. When you want to apply the hold on a per document basis, do not assign a document type. Instead, grant the Assign from Grid privilege. Users with this privilege can apply the hold directly to a document from ImageNow Explorer.

When required, you can assign multiple holds to the same document. When this occurs, the document remains under hold until all holds are removed. Additionally, you can apply a hold to a document that is under a retention policy. In this scenario, you are unable to modify or delete the document even when the retention period expires.

Grant hold manager privileges

To create and manage holds, you must have the global Manage Retention Holds privilege. When you have this privilege, you are able to access the Holds pane in the Retention area of the Management Console.

1. In the Management Console, to grant privileges to a user or group, perform one of the following actions:
   - To grant a privilege to a user:
     1. In the left pane, click User.
     2. In the right pane, on the Security tab, in the Select a user list, select a user and then click Modify. If the user you want is not listed, in the Search for users box, type all or part of a user name, first or last name.
     3. Click Search. In the Select a user list, select one or more users and then click Modify.
   - To grant a privilege to a group:
     1. In the left pane, click Groups.
     2. In the right pane, on the Security tab, in the Select a group list, select a group and then click Modify. If the group you want is not listed, in the Search for groups box, type all or part of a group name and then click Search. In the Select a group list, select a group and then click Modify.

   Note To sort the Select a group list in ascending or descending order, click the Name column header.

2. In the Security Settings dialog box, click the Global Privileges pane.
3. In the Privileges list, under Manage, select the Retention Holds privilege.
4. Click the column to the left of the privilege so that ✓ displays to grant the privilege.
5. Click OK until you return to the Management Console.

Create a hold

1. In Management Console, in the left pane, expand Retention.
2. Under Retention, click Holds.
3. In the right pane, on the **Holds** tab, click **New**.

4. In the **New Hold** dialog box, perform the following substeps:
   
   1. To set the hold properties, perform the following substeps:
      
      1. On the **Properties** tab, in the **Name** box, type a hold name.
      
      2. Optional. In the **Description** box, type a description.
      
      3. In the **Duration** section, perform one of the following actions:
         
         • To create a permanent hold, select **Indefinite**.
         
         • To create a hold that expires, select **Expiration date** and then set the date and time you want the hold to expire.
      
      4. To activate this hold, select the **Active** check box.
      
   2. Optional. To add hold reasons, perform the following action:
      
      • On the **Reasons** tab, under **Available**, select one or more reasons for applying this hold and then click **Add**.
      
   3. Optional. To assign this hold at the document type level, perform the following substeps:
      
      1. On the **Assignment** tab, to apply the hold, in the **Type** list, select **Document type**.
      
      2. Under **Available**, select one or more document types and then click **Add**.
      
      **Note** To select multiple document types, press CTRL.
   
   4. Optional. To grant use of this hold from ImageNow Explorer, perform the following substeps:
      
      1. On the **Security** tab, click **Add**.
      
      2. In the **Select User** dialog box, perform one of the following actions:
         
         • In the **Search results** list, select one or more users, click **Add** and then click **OK**.
         
         • In the **Search for users** box, type all or part of a first name, last name, or user name of the user you want, and then click **Search**. In the **Search results** list, select one or more users, click **Add** and then click **OK**.
      
      3. Under **Privileges**, perform one or more of the following actions:
         
         • To allow a user to apply a direct hold from ImageNow Explorer, click the column in front of **Assign from Grid** until **✓** appears.
         
         • To allow a user to remove the hold from ImageNow Explorer, click the column in front of **Remove from Grid** until **✓** appears.
         
         • To allow a user to search for the hold from ImageNow Explorer when applied as a direct or inherited hold, click the column in front of **Search from Grid** until **✓** appears.
      
   5. Click **OK**.

**Notes**

• When you assign a hold at the document type level, all items indexed with that document type inherit the hold.

• If you do not want to place all items indexed with a document type under a hold, do not assign the document type.
Retention for the everyday user

With Perceptive Software’s retention functionality, you can manage the lifecycle of your organization’s documents. As documents move through the lifecycle of a retention policy, you can determine whether a document is under a protected phase, assign physical file references, approve disposition actions, and apply document holds.

You can use the retention columns in ImageNow or WebNow Explorer to view documents that fall under a policy, documents that fall under a protected phase in a policy, and documents that are associated with a physical file reference. Retention columns are available for document views, project views, and workflow views.

To track the physical location of a document, you can create a physical file reference using a physical file template. For example, you can designate a warehouse, shelf number, or box number as a physical location. You can create a physical file reference for any document in your system from ImageNow or WebNow Explorer and ImageNow or WebNow Viewer. For more information about physical file templates, refer to the “About physical file templates” section.

If a policy creator designates you as an approver, you must approve the path disposition action, such as destruction, offline transfer, or accession, before that action can occur for the documents that fall under that path. When the retention period ends, Retention Policy Manager automatically creates an approval task for you. To approve the disposition action, you simply approve the approval task. You can view the approval tasks assigned to you in the My Assigned Tasks view. For more information about approval tasks, refer to the “About approval tasks” section.

A hold allows you to preserve a document. When you apply a document hold, no changes to that document can occur until you remove that hold or the hold expires. You can search for documents that are currently under a hold from ImageNow or WebNow Explorer. In addition, you can view the hold history for all documents. For more information about document holds, refer to the “About document holds” section.

Add retention columns

Follow this procedure to add columns that allow you to view the documents that fall under a retention policy, appear under a protected phase within a policy, or have a reference to a physical file in an offline location.

1. With a view or filter displayed in ImageNow Explorer, click the Columns button.

2. In the Columns dialog box, perform any of the following actions:
   • To display which documents fall under a retention policy, click the Under Policy check box.
   • To display the documents that fall under a protected phase within a retention policy, click the Is Protected check box.
   • To display the documents that have a reference to a physical location, click the Has Physical File Reference check box.

   **Note** You can also display the Has Physical File Reference column in the workflow item search grid.

3. Click OK.
About physical file references

Physical file references allow you to track the physical location of your documents. You can create a physical reference when you want to designate the building, shelf, or box location of your physical documents. Physical file references can contain associated physical properties that provide additional information about the physical location. You can associate a physical file reference with any document in your system.

Create a physical file reference

When you create a physical file reference in the Viewer, you select an item from a list of previously created physical file templates.

1. In ImageNow Viewer, in the Actions pane, click Create physical file references.
2. In the Create Physical File References dialog box, select an item in the Select a physical file template list.
3. Modify the Physical properties table as needed.
4. Click OK.

Note After you create the physical file reference on a document, the physical file reference indicator appears in the status bar in ImageNow Viewer and in the Has Physical File Reference column in the ImageNow Explorer grid.

Search for documents with a physical file reference

1. In the Search tab, click the Add button.
2. In the Add Condition dialog box, perform the following substeps:
   1. In the Constrain by list, click Status.
   2. In the Type list, verify that Normal displays.
   3. In the Field list, click Has physical file reference.
   4. In the Operator list, verify that is equal to displays.
   5. In the Value box, verify that Yes displays.
   6. Click OK.
3. Click the Go button.

About approval tasks

An approval task is a task type that Retention Policy Designer automatically generates for all approvers assigned within a retention policy. An approver is a user or group member that must approve the disposition action set in a policy before that action can occur. When the retention period ends, Retention Policy Designer creates an approval task and associates that task with the set of documents that are ready for approval.

After the task is created, Retention Policy Designer assigns that task to the approver. If multiple approvers are defined, Retention Policy Designer assigns an individual task to each user or group member. To streamline the approval process, Retention Policy Designer sends e-mail notifications to all approvers. A notification includes a link to the approval task and any instructions entered by the policy creator.
To process an approval task, an approver can open the e-mail notification link or access the My Assigned task view in ImageNow Explorer or WebNow Explorer. The task and the set of documents associated with that task appear in ImageNow Project Viewer or WebNow Project Viewer. Project Viewer allows an approver to view the documents before approving them. To approve the disposition action for the documents, the approver simply approves the task associated with the document set. The disposition action can occur only after each approver approves his or her approval task. After an approver processes an approval task, that task no longer appears.

Process an approval task

If you want to approve a set of documents in a single step, you can use this procedure. However, if you prefer to process the documents one at a time, refer to the "Process an approval request" section. The Reason list is unavailable and appears dimmed for approval tasks.

1. On the ImageNow toolbar, click the Tasks down arrow and then click My Assigned.
2. In ImageNow Explorer, in the Tasks grid, open the task you want to process.
3. Optional. In ImageNow Project Viewer, to view the set of documents associated with the approval task, click the Documents tab. Double-click a document to open it.
4. To verify the disposition action and approver instructions, on the Tasks tab, in the Approval Request pane, review the Instructions field.
5. Optional. To add comments to the task, on the Tasks tab, in the Approval Request pane, under Comments, click Add and then perform the following substeps:
   1. In the Task Comments dialog box, in the Enter text box, type your comments and then click Add.
      
      Note Comments appear in the History box and are not modifiable.
   2. Optional. To print comment history, click Print and then select the printer to which you want to print.
   3. Click Close.
6. Optional. To return the task to any user with the Manage Retention Policies privilege, click Return.
7. To approve the disposition action for all of the documents associated with the approval task, in the Approval Request pane, click Approve All.

Search for approval tasks

1. On the ImageNow toolbar, click My Assigned.
2. Perform the following action to search for tasks that require your approval:
   - To search on a single field
     1. In ImageNow Explorer, click the Quick Search tab.
     2. On the Quick Search tab, define the search condition:
        1. In the property list, click Task type.
        2. In the operator list, verify that is equal to is displayed.
        3. In the value box, verify that Approval is displayed.
     3. Click the Go button.
     4. In the tasks grid, in the result set, double-click a task to open it in the viewer.
To search on multiple fields

1. In **ImageNow Explorer**, click the **Search** tab and then perform the following substeps:
   1. Click the **Add** button.
   2. In the **Add Condition** dialog box, in the **Constrain by** list, select **Task property**.
   3. In the **Type** list, verify that **Normal** is displayed.
   4. In the **Field** list, click **Task type**.
   5. In the **Operator** list, verify that **is equal to** is displayed.
   6. In the **Value** box, verify that **Approval** is displayed.
   7. Click **OK**.
2. To add another condition row, repeat the previous substeps.
   
   **Note** Each new row begins with **AND** by default. To change **AND** to **OR**, click it.
3. Click the **Go** button.

Optional. If you want to save the search as a filter, complete the following substeps:

1. Click the **Save Private Filter** button.
2. Optional. In the **Save Filter** dialog box, give the filter a name and an optional description and then click **OK**.

**Process an approval request**

If you are listed as an approver by your records manager, you may be asked to respond to approval requests. The following procedure shows you how to process requests one at a time from a document view. If you have a large set of documents and prefer to process them in smaller groups, you can use this procedure. However, if you only need to process a set of requests in a single step, refer to the “Process an approval task” section.

1. In **ImageNow Explorer**, click the **Columns** button, in the **Columns** dialog box, select the **Under Policy** check box, and then do one of the following actions.
   
   - To show all Under Policy documents in the grid, in the **Views** pane, under **Documents**, click **All Documents**, click the **Go** button, and then, in the search grid, click the **Under Policy** column heading.
   
   - Create a private filter that automatically shows the **Under Policy** column and prompts you for a search key to return just the group of documents you want to process.

2. Complete the following substeps:
   1. In the list of **Under Policy** documents, double-click the document you want.
   2. In **ImageNow Viewer**, in the **Actions** pane, under **Document**, click **Process approval requests**.
   3. In the **Process Approval Requests** dialog box, do one of the following actions:
      
      - To approve the request, click **Approve**.
      - To postpone acting on the request, click **Skip**.
   3. If you have approval requests for other documents, repeat the previous substeps for each document.
About document holds

A hold allows you to preserve a document. No user can modify or delete a document under a hold. You can apply a hold for a specific period of time or indefinitely. When you apply a hold to a document that is under a retention policy, you are unable to modify, delete, or transfer that document even when the retention period expires. Holds are applied on a per document basis. You can assign or remove holds in the Hold Assignment dialog box, accessible from ImageNow or WebNow Explorer.

There are two levels of hold assignment: direct and inherited. A direct hold is a hold that you apply to the document from ImageNow or WebNow Explorer. When you apply a hold to a document type, it is an inherited hold for all documents of that document type.

Your retention manager applies inherited holds in Retention Policy Manager. You can apply multiple holds to the same document. When this situation occurs, the document remains under hold until all applied holds are removed. You can remove direct holds, but you cannot remove inherited holds unless you are the manager, the owner, or have the global Manage Retention Holds privilege.

Apply a document hold

Follow this procedure to apply a hold from ImageNow Explorer. To perform this procedure, you must have the Assign from Grid privilege for the hold.

1. In ImageNow Explorer, right-click the item to which you want to apply the hold and then click Holds.
2. In the Hold Assignment dialog box, perform the following substeps:
   1. Under Available, select one or more holds and then click Add.
   2. Optional. In the Comment box, type the reason you are applying a hold.
   3. Click OK.

Notes

- Currently applied holds appear under Selected.
- When you select multiple items in ImageNow Explorer, currently applied holds do not display in the Selected section. To view applied holds, select a single item.
- When a hold is applied at the document type level, it displays as "Inherited" in the Assignment column.

Search for documents on hold

1. In the Search tab, click the Add button.
2. In the Add Condition dialog box, perform one of the following actions:
   - To search for a document on hold
     1. In the Constrain by list, click Status.
     2. In the Type list, verify that Normal displays.
     3. In the Field list, click Is on hold.
     4. In the Operator list, click is equal to.
     5. In the Value box, click Yes.
     6. Click OK.
• To search for a document by hold name
  1. In the **Constrain by** list, click **Document property**.
  2. In the **Type** list, verify that **Normal displays**.
  3. In the **Field** list, click **Hold name**.
  4. In the **Operator** list, click **is equal to**.
  5. In the **Value** box, select the hold.
  6. Click **OK**.

3. Click the **Go** button.
### Glossary of retention terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accession</td>
<td>The transfer of physical and legal custody of documentary materials to another owner, such as an archival institution.</td>
</tr>
<tr>
<td>Authority</td>
<td>The legal, regulatory, statutory, or operational entity, such as the federal government or a legal department, that defines the lifecycle requirements for a document.</td>
</tr>
<tr>
<td>Destruction</td>
<td>The action or process of destroying physical or electronic documents beyond any possible restoration.</td>
</tr>
<tr>
<td>Disposition</td>
<td>A final action taken regarding documents after they are no longer required for day-to-day-access.</td>
</tr>
<tr>
<td>Event</td>
<td>An event triggers the retention period of a policy and is, in turn, triggered when conditions are satisfied.</td>
</tr>
<tr>
<td>Executed policy</td>
<td>The retention policy that is currently applied.</td>
</tr>
<tr>
<td>Hold</td>
<td>A hold defines a period of time in which a document cannot be modified, destroyed or transferred, even when its retention period is met.</td>
</tr>
<tr>
<td>Offline storage</td>
<td>This storage option means that metadata is stored on your ImageNow system and that there is an entry point to its location. This type of storage always requires human intervention. You restore data to where it was staged with offline storage. Physical objects and subobjects, such as annotations and forms data, are transferred with the document.</td>
</tr>
<tr>
<td>Online transfer</td>
<td>This storage option is instantly accessible by ImageNow. Online storage does not require any human intervention. The location of this storage must be accessible by ImageNow Server using a local or mapped network drive.</td>
</tr>
<tr>
<td>Path</td>
<td>The location of a document during a policy phase.</td>
</tr>
<tr>
<td>Path details</td>
<td>The time, event, or time and event based rules you define to determine where a document falls within a policy. In addition, you use path details to assign approvers and set the disposition action that occurs after the retention period ends.</td>
</tr>
<tr>
<td>Permanent</td>
<td>A final disposition action that preserves documents indefinitely.</td>
</tr>
<tr>
<td>Phase</td>
<td>The particular time in the document lifecycle.</td>
</tr>
<tr>
<td>Phase start date</td>
<td>The date when all conditions necessary for a phase are met.</td>
</tr>
<tr>
<td>Physical file</td>
<td>The hardcopy version of a document.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Protected</td>
<td>A document that is under a protected phase or policy. A user can make limited modifications, such as applying annotations and digital signatures, to a protected document.</td>
</tr>
<tr>
<td>Retention policy</td>
<td>A policy determines the length of time a document is retained and describes what to do with the document after the retention period expires.</td>
</tr>
<tr>
<td>Retention schedule</td>
<td>A list that describes the length of time you need to retain each document type to meet the legal, administrative, and historical requirements of your organization. A retention schedule also includes the final disposition for a document type after the retention period is met.</td>
</tr>
<tr>
<td>System metadata</td>
<td>This metadata stores special purpose information, which can include who captured, modified, or linked a document. This information is automatically-populated and managed in ImageNow.</td>
</tr>
<tr>
<td>Time period</td>
<td>The rule type you use to set the duration of the retention period when an event rule is also defined for the policy or to create a time based policy.</td>
</tr>
<tr>
<td>Unprotected</td>
<td>A document that is under an unprotected phase or policy can be modified or deleted by a user with the appropriate privileges.</td>
</tr>
</tbody>
</table>

**Hold privilege definitions**

Privileges are assigned to users or groups by a user with management privileges, a manager or the owner. In ImageNow, you assign privileges to control the actions that users can perform. Privileges can be assigned at the user or group level. This table lists all of the privileges associated with holds. This table also lists the privilege definition, dependency information, and the privilege location. The location column assumes you have expanded Retention in Management Console, clicked Holds, and are creating or modifying a hold.

<table>
<thead>
<tr>
<th>Type</th>
<th>Definition</th>
<th>Dependency</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign from Grid</td>
<td>The user can apply this hold directly to items from ImageNow or WebNow Explorer grid. By default, a user with this privilege can search for this hold, in the Add Condition dialog box, in ImageNow or WebNow Explorer. You do not have to grant a user with this privilege the Search from Grid privilege below.</td>
<td>This privilege has no dependencies.</td>
<td>In the New Hold or Modify Hold dialog box on the Security tab.</td>
</tr>
<tr>
<td>Type</td>
<td>Definition</td>
<td>Dependency</td>
<td>Location</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Remove from Grid</td>
<td>The user can remove this hold from documents in ImageNow or WebNow Explorer grid. A user can remove direct holds from ImageNow or WebNow Explorer with this privilege, but cannot remove inherited holds. By default, a user with this privilege can search for this hold, in the Add Condition dialog box, in ImageNow or WebNow Explorer.</td>
<td>This privilege has no dependencies.</td>
<td>In the New Hold or Modify Hold dialog box on the Security tab.</td>
</tr>
<tr>
<td>Search from Grid</td>
<td>The user can search for this hold, in the Add Condition dialog box, in ImageNow or WebNow Explorer. This search returns items that are under this hold when applied as a direct or an inherited hold.</td>
<td>This privilege has no dependencies.</td>
<td>In the New Hold or Modify Hold dialog box on the Security tab.</td>
</tr>
</tbody>
</table>
Index

actions
  overview ....................................................... 16
adding
  retention columns ......................................... 59
applying
  document holds ............................................ 63
approval levels
  overview ....................................................... 16
approval requests
  processing .................................................... 62
approval tasks
  overview ....................................................... 60
  processing .................................................... 61
  searching ...................................................... 61
approvers
  overview ....................................................... 15
assigning
  authorities ....................................................... 9
authorities
  assigning ....................................................... 9
  creating ........................................................... 9
  overview ......................................................... 9
based on events
  creating advanced policies ......................... 35
  creating simple policies ............................. 21
based on time
  creating advanced policies .......................... 43
  creating simple policies .............................. 23
based on time and event
  creating simple policies ......................... 18, 27
confirming
  copy sets ..................................................... 56
  destruction sets ............................................ 53
  export sets ..................................................... 55
  move sets ..................................................... 56
copy set reports
  generating ..................................................... 56
copy sets
  confirming ..................................................... 56
  verifying ..................................................... 56
creating
  authorities ..................................................... 9
  date periods ................................................. 9
  holds ............................................................. 57
  physical file references ..................................... 60
  physical file templates ...................................... 13
  physical locations ........................................... 10
  physical properties ........................................... 11
creating advanced policies
  based on events ........................................... 35
  based on time ................................................. 43
  based on time and event .................................... 27
creating simple policies
  based on events ........................................... 21
  based on time ................................................. 23
  based on time and event .................................... 18
date periods
  creating ......................................................... 9
  overview ......................................................... 9
defining
  retention policies ............................................ 7
definitions
  hold privileges .............................................. 66
  retention terms .............................................. 65
destruction set reports
  generating ..................................................... 53
destruction sets
  confirming ..................................................... 53
  overview ......................................................... 53
  verifying ......................................................... 53
document holds
  applying ......................................................... 63
  overview ......................................................... 63
documents on hold
  searching ......................................................... 63
documents with physical file references
  searching .................................................. 60
event and time based policies
  overview ................................................... 15
event based policies
  overview ................................................... 15
event rules
  overview ................................................... 15
export set reports
  generating .................................................. 54
export sets
  confirming .................................................. 55
  overview .................................................... 54
  verifying .................................................... 55
generating
  copy set reports ........................................... 56
  destruction set reports .................................. 53
  export set reports ........................................ 54
  move set reports .......................................... 56
glossary
  retention terms ........................................... 65
granting
  hold manager privileges .................................... 57
  retention policies privileges ................................ 8
hold manager privileges
  granting .................................................... 57
hold manager role .......................................... 8
hold privileges
  definitions ................................................... 66
holds
  creating .................................................... 57
  overview .................................................... 57
licensing requirements ........................................ 7
move and copy sets
  overview .................................................... 55
move set reports
  generating ................................................... 56
move sets
  confirming ................................................... 56
  verifying .................................................... 56
overview
  actions ....................................................... 16
  approval levels .......................................... 16
  approval tasks ............................................. 60
  approvers .................................................... 15
  authorities ..................................................... 9
  date periods .................................................. 9
  destruction sets .......................................... 53
document holds .............................................. 63
event and time based policies ................................ 15
  event based policies ........................................ 15
  event rules .................................................... 15
  export sets ................................................... 54
  holds ......................................................... 57
  move and copy sets ........................................ 55
  path details .................................................... 14
  paths ......................................................... 14
  phases ......................................................... 14
physical file references ....................................... 60
physical file templates ........................................ 11
physical locations ............................................. 10
physical properties ............................................. 11
dates and time based policies ................................ 15
time rules ....................................................... 15
using retention .................................................. 59
owner or manager role .......................................... 8
path details
  overview ....................................................... 14
paths
  overview ....................................................... 14
phases
  overview ....................................................... 14
physical file references
  creating ....................................................... 60
overview .......................................................60
searching for documents with .......................60
physical file templates
creating ................................................................13
overview .........................................................11
physical locations
creating ...............................................................10
overview .........................................................10
physical properties
creating ...............................................................11
overview .........................................................11
policies and document types
overview .........................................................17
policy manager role .............................................8
processing
approval tasks ....................................................61
protecting policies and phases
overview .........................................................17
retention columns
adding ...............................................................59
retention policies
defining .............................................................7
retention policies privileges
granting ...............................................................8
Retention Policy Designer
overview .........................................................14
Retention Policy Manager
overview .............................................................7
retention sets
overview .........................................................53
retention terms
definitions ..........................................................65
glossary ..........................................................65
roles
hold managers .....................................................8
overview ..........................................................8
owner or managers ...............................................8
policy managers ..................................................8
users .................................................................8
searching
approval tasks .....................................................61
documents on hold .............................................63
time based policies
overview ..........................................................15
time rules
overview ..........................................................15
using retention
overview ..........................................................59
verifying
copy sets ..........................................................56
destruction sets ..................................................53
export sets ..........................................................55
move sets ..........................................................56